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PREFACE

This document contains all of the database notes and How-To files from within BIRDD. These can
be printed to provide a "manual" for students to refer to. Instructors can distribute copies of
whichever pages are appropriate for the assignments they give their students.
These notes can also be viewed from within the BIRDD application by clicking on the "How To ….."
button on the database Contents screens.

NOTE:
This document requires Version 4.0 or later of the Adobe Acrobat ™ Reader. With earlier
versions of the Reader some of the graphics will display poorly or not at all. Version 4.0 of
the Reader is available on the CD and can be installed from the Library Guide.
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DATA
Data Files
+ DFMain: a table of contents for all the project files.
+

DFMorph: morphological measurements

+

DFDNA: DNA and protein sequences

+

DFTaxa: information about species.

+

DFVocal: vocalizations

+

Islands: information on islands

+

Weather: mostly rainfall and temperature

+

GalPics: images

+

Biblio: Literature

+

GalTrsts: tourist visits

Island Names & Abbreviations
Finch Names & Abbreviations

USING BIRDD
Navigating the Databases
Tables of Contents
Data Displays
Menus
Standard Scripts on the Script Menu
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Notes on BIRDD: Topics
Printing
Selecting Subsets of Data
Exporting Data

INSTALLATION & TROUBLESHOOTING
Installation Issues
To use the Online Guide to install BIRDD:
Fonts
Screen Resolution and Color Depth
Printing
Panoramas And Sounds
File Organization

Trouble-shooting
Printing Problems: Text or images are cut off
Panoramas don't work
Sounds Do not work on Windows PCs
Sounds Do not work on Macs

VERSION NOTES: 2.0
Modifications To Run On Windows Computers
Other Changes
Changes To Individual Data Sets
Morphology Database:
Molecular Sequence Database:
Species Database:
Vocalization Database:
Islands Database:
Weather Database: no changes
Pictures Database: New
Bibliography Database: New
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Tourists Database: New
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Notes on BIRDD
INTRODUCTION
The primary goal of the BIRDD (Beagle Investigations Return with Darwinian Data) project is
to provide students and instructors with a variety of resources related to evolution research and
to the teaching of evolution. It is difficult for students to understand evolution unless they have
an opportunity to study it as they study other areas of biology — by doing what professionals
in the discipline do in labs, in museums, or in the field.
Unfortunately, labs have been rare in courses dealing with evolution, and with some justification.
Evolutionary phenomena involve time and geographic scales that make it difficult for instructors
to develop labs comparable to those in biochemistry, physiology or behavior.
Yet we need only look to examples of evolution research to see how these obstacles have been
overcome. Evolution research involves the synthesis of many types of data and often does not
directly test hypotheses with experimental protocols. A great deal can be learned using
comparative methods. Making comparisons between species and looking for associations
between traits and ecological conditions allows evolutionary biologists to test hypotheses about
adaptations (Harvey and Pagel, 1991; Freeman, and Herron, 1998). We must not allow a narrow
view of the nature of science to limit the opportunities that students have to learn about
evolutionary phenomena through their own scientific inquiries.
BIRDD aims to lower the threshold for getting students actively involved with evolutionary
problem solving by providing:
1. raw data students may work with and
2. pedagogical ideas to help instructors structure appropriate experiences for their students.
One of the most difficult aspects of teaching biology is how to help students understand what it
means to engage in evolutionary reasoning. There are very few activities available that allow
students to pursue investigations homologous to those of evolutionary biologists. This project
grew out of a belief in the value of these types of investigations for students.
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Notes on BIRDD
The Data Resources
Unlike most BioQUEST modules, BIRDD is neither a simulation nor a text module. There are no
predetermined experiments to “run”. Instead, there are rich data that can be used to develop
investigations that explore evolutionary phenomena in a realistic manner. These permit
observational hypothesis testing in contrast to the experimental hypothesis testing that most
people understand to be "the scientific method".
Too often doing science is exclusively associated with collecting data while the analysis and
interpretation of those data are underemphasized. Evolutionary biology and ecology have always
involved the integration of diverse data to identify new patterns and to build models to explain
those patterns.
The Darwin's Finch Data Resource (DFDR) is the first BIRDD module and contains a
collection of scientific data related to Darwin’s Finches. Our primary goal has been to compile as
many raw data as possible and to organize them so they are easily accessible. The aim is to put
students in the position of John Gould (who first named and described the finches) and other
scientists in England who received the specimens Darwin brought back from his voyage on HMS
Beagle. Of course the range of data and their presentation reflect 150 years of progress in science
and technology!
Data printed in books and journals are difficult to use because they are typically "processed"
statistics and tabulations and students cannot analyze them further — raw data are hard to find.
Even if raw data are available in printed form, students or instructors must first enter and
proofread them, a daunting task for even a moderately large data set. The DFDR lowers the
threshold for using raw data by collecting them and providing them in electronic form for review
and export of other software.
The databases provide
+ A body of background information: e.g., island names, taxonomic names, maps;
+ A large volume of diverse data: e.g., beak dimensions, molecular sequences;
+ Simple statistics and information displays: help students understand the data.
+ Sources of data for other software: allow use of data in other programs.
+ An easy, consistent, user interface: facilitates moving around, viewing and printing
data and background information;
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The Instructional Resources
While data resources are obviously an important part of helping students experience
problem-solving in evolutionary biology, data alone do not constitute a rich educational
experience. Because BIRDD is designed to support the broadest possible range of uses, new
users, both students and teachers, may not know how to get started. To help orient new users,
we have begun to collect examples of some of the different ways BIRDD has been used in a
variety of institutions and courses.
Clearly, understanding evolutionary theory is an essential component of learning biology. Yet,
despite its central role, teaching and learning evolution continues to be problematic. Even without
the confusion caused by the political and religious attacks on evolution education, evolutionary
concepts are both difficult to teach and difficult for students to understand. We feel that is is
important to allow students to move beyond textbook presentations of canonical evolution
stories to experience for themselves how data are used to support scientific claims. Without the
opportunity to define and explore their own questions, how can we expect students to
understand scientific ways of knowing, particularly the diverse and nuanced collection of
approaches we call evolutionary biology? The data available within BIRDD can be used to
support realistic scientific inquiry into evolutionary phenomena.
Briefly, some of the roles BIRDD might play in teaching and learning include:
+ Reference library: a source of ideas and background information and summaries that can
help students ask questions about evolutionary phenomena.
+ Data library: a source of data to help answer questions asked by students.
+ Curricular resource: a source teachers can use to develop custom exercises.
+ Source of presentation materials: for maps, images and data for lectures and reports.
The Documentation folder contains a Teaching Resources folder with additional resources to
help users think about teaching and learning with BIRDD:
+ TeachingEvolution.pdf discusses some of the educational issues involved in teaching
evolutionary biology;
+ ClassRmExamples.pdf shows how BIRDD has been used in a variety of majors' and
non-majors' biology courses in large and small schools;
+ GettingStarted.pdf contains tutorials illustrating how to use the BIRDD to
1. Navigate to find and print reference information, data and summaries;
2. Export numeric data and analyze them in other applications
3. Export non-numeric data like images, panoramas and sounds to other applicatons
4. Work through a question and analysis.
Our Web site, http://bioquest.org/birdd/, includes these and additional materials related to
teaching and learning with BIRDD.
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Request for Feedback & Suggestions
This module is a work in progress. As you will see, we have collected and organized a variety of
potentially useful data and materials, but we plan to add more. As the project evolves, we hope
BIRDD will support truly novel approaches to teaching evolution.
We are anxious for your feedback on the materials provided here: your ideas for how these
resources can be used in teaching biology, and your suggestions for future directions of the
project. We are dependent on you to share your experiences and insight to make this module
more useful.
While faculty and students using BIRDD cannot modify the contents of the data files, we
welcome suggestions for additional data. We especially urge researchers with suitable raw data to
contact us about adding more data.
Frank Price <fprice@hamilton.edu>.
Sam Donovan <ssdonova@students.wisc.edu>.
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Historical Perspective on Darwin's Finches
Early bird taxonomists did their work "over the barrel of a gun" and prepared stuffed "study
skins" that form the core of most museum collections. They usually based species descriptions
on the morphology, color, etc. of small numbers of specimens, often only one.
Inherent in Darwin's theory of evolution was the idea that species were populations of
individuals and that species descriptions should be based on statistically adequate samples.
Moreover, there are many more important characteristics than the static morphology of a stuffed
specimen, e.g., soft-tissue anatomy, behavior, life history, biomolecular sequences, etc.
From hindsight, much of the early work was crude and of very limited scope; nevertheless
researchers such as John Gould, Robert Ridgway, and others paved the way toward our current
conception of the evolution and taxonomy of Darwin's finches. Collecting expeditions in the late
1800's and especially the Hopkins-Stanford Galapagos Expedition in 1905-6 provided most of
the specimens of Darwin's finches available in museums.
With the development of new statistical techniques and the advent of population genetics in the
1930's, taxonomists began to examine larger numbers of specimens. In the late 1920s Harry
Swarth attempted to examine at least ten specimens of each species from each island, and his
1931 monograph was a milestone that set the foundation of our taxonomy of the finches.
His work was an intermediate step; in the late 1930's David Lack measured every specimen he
could get his calipers on. He also made pioneering field observations and was the first to do
major taxonomic work after having seen living finches in the wild. He made relatively minor
changes in Swarth's taxonomy on the basis of his larger samples; more significantly, he used the
finches as a test case for a number of larger questions such as the roles of competition,
geographic isolation, and environmental diversity in evolution. His works (Lack, 1945, 1947) are
classics, and a foundation for subsequent studies.
In the 1950's and '60's, researchers followed up on issues raised by Lack. Workers such as
Robert Bowman, and Peter and Rosemary Grant, and their students began studies that continue
to expand our understanding of evolution. See Weiner (1994) for a very readable account of some
of this work. Diagrams from Lack and Grants' work are canonical illustrations of evolution and
adaptive radiation in many introductory textbooks.
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Data Archives and Digital Libraries
While research such as that sketched above is important, it does not by itself provide material
that students can use to gain practical experience. The only way for students to learn how
professionals pursue their craft is to work with the similar materials, tools, methods, and
questions. For evolutionary biology this often requires access to data collected by someone else.
Traditionally, publication of raw data has been too expensive, and museum collections are
inaccessible to most instructors and students. Fortunately information technology has made it
more practical to provide digital libraries of numeric data, images, sounds, etc. This was the
original purpose behind the BIRDD project.
The recent emergence of vast quantities of publically-available data such as molecular sequence
data (Benson, et al., 1999) and data from the LTER (Long Term Ecological Research) sites
(Sprott, 1998) will continue to increase the need for students to understand how to "mine" data
resources in meaningful ways.
Moreover, access to archives of raw data can be important for professionals as well as for
students. Museum collections have always been important for evolutionary biologists, but they
are becoming even more important because original collecting has become very difficult for fiscal,
legal, bureaucratic, and ethical reasons. Professionals will also benefit from having data available
for reexamination. BIRDD will make more canonical data sets like those of Swarth, Lack and
others more available.
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DATA
Data Files
The data are organized in a number of separate database files and each database has a "Notes"
display with additional information. You needn't remember the names of files, BIRDD handles
file-switching for you.
+ DFMain: a table of contents for all the project files.
It displays a series of buttons that open other files or provide information about the entire
system -- like these notes.
+

DFMorph: morphological measurements
Contains data from over 7,400 individual Darwin's finches. The majority of the data are
beak/bill dimensions. Included are measurements on 51 historically important specimens
collected by Charles Darwin and others on HMS Beagle. The file also contains buttons to
display summary statistics of species and subspecies on different islands.

+

DFDNA: DNA and protein sequences
Data on seven molecules from over 200 individual finches, and several possible sister
species.

+

DFTaxa: information about species.
The data include information on species recognition (pictures, descriptions), islands
inhabited, ecological information such as habitats, food and foraging habits, and illustrations
of skull and jaw musculature. At present, most of the data are on the 13 species living on the
Galápagos archipelago itself. Additional data on genera, subspecies and the Cocos Island
Finch (Pinaroloxias inornatus) may be added later. The notes on this file contain information
about the bewildering variety of names that have been applied to Darwin's finches and
explains names and abbreviations we use throughout the DFDR.

+

DFVocal: vocalizations
Songs and other vocalizations, along with sonograms and waveform diagrams.

+

Islands: information on islands
Contains data about 39 of the islands in the Galápagos Archipelago. Data include finches
that live on the island, vegetation zones, physical dimensions and age. There are also maps of
the archipelago and of each island.

+

Weather: mostly rainfall and temperature
Contains about 40 years of monthly rainfall data at one location, and monthly averages of
temperature, rainfall and other parameters at several locations and elevations.
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+

GalPics: images
Contains a number of habitat panoramas and pictures of habitats and organisms, as well as
notes by students who took many of the images.

+

Biblio: Literature
Contains a bibliography of over 300 entries on Darwin's finches and on the Galápagos in
general

+

GalTrsts: tourist visits
Contains data on the number of tourists visiting the island per month from 1979 into 1997.

Island Names & Abbreviations
The islands of the Galápagos archipelago are referred to by a bewildering variety of names that
derive from sources that range from pirates to W.W.II military personnel. Much of the older
literature refers to English names, while more recent literature tends to employ common names
used by the local inhabitants. Many writers use a mixture.
Because of this confusion, we have decided to use as “Island name” a combination of the
common name and the English name used in the classic literature. However, students should be
aware that some confusion is inevitable. For example, “Seymour” may refer to North Seymour
(this appears to be the modern usage), or to Baltra (also known as South Seymour and Seymour
Sur).
Wherever possible, island names are displayed as “Common Name / English Name” to help you
learn both. When space is at a premium, we use a shorter "Island ID" that contains shortened
forms of both. Thus, Baltra is displayed as "Baltra / South Seymour" when there is space, and
"Balt_SS" when necessary.

Finch Names & Abbreviations
Similarly, names of finches are spelled out fully where possible. Where space is limited we use
an abbreviated ID that is the first three characters of the genus, specific name, and subspecies
name if appropriate. For example, the Large tree finch is designated by Camarhynchus
psittacula or by Cam.psi. There is a button in the DFTaxa Table of Contents that will display
and print a summary of the IDs, taxonomic names, synonyms, and common names.
In data sets, e.g., DFMorph, derived from published sources, we have included taxon names used
by original authors as well as our "standardized" names.
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USING BIRDD
Much of the following can be found in the help information provided by the How-To buttons in
the various databases. You should examine those displays whenever you first open a database
and when you are uncertain about how to proceed.

Navigating the Databases
Click the Notes on the How To Navigate Around BIRDD button on the Main table of contents
for annotated images of BIRDD's tables of contents, data windows and controls, etc.
Tables of Contents
Opening the BIRDD application icon brings up the Main Table of Contents for all of the files. It
contains a number of buttons which display background information or take you to relevant data
files and displays. Click once on a button and the appropriate information or database will
appear. The main table of contents mirrors the organization of most of the other databases:
+ Notes Button: In the upper left is a wide button that takes you to background text
describing the data (e.g., these Notes on BIRDD)
+ How-To Button: In the upper right there is a square "How-To" button that displays
information on how to use the database and how to interpret the data.
+ Display Buttons: In the middle are buttons that take you to databases; in individual
database these buttons take you to different data displays.
+ Quit/Back Button: In the lower left is another wide button that quits from BIRDD; in
individual databases the lower-left button returns to the main table of contents.
Each database has its own Table of Contents and appropriate buttons.
The first time you open BIRDD or any of its databases, you should check out the Notes and
How-To buttons before using the display buttons.
Data Displays
Most of BIRDD's data displays look like printed pages, and window size and position are
automatic. Although BIRDD has the usual menus and window controls, most of them need not
be used.
Menus
Only three of the menus are of significant use within BIRDD:
+ The File Menu allows you to Print the information you are viewing.
+ The Script Menu allows you to select various information displays and mostly parallel
the buttons in the database's Table of Contents.
+ The Mode Menu allows you to move between Browse mode (where you see raw data and
buttons) and Preview mode where you see printed pages and summary data.
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Standard Scripts on the Script Menu
Each database also has a series of scripts visible on the Script menu. The first seven scripts are
the same in all databases and have the keyboard equivalents shown below:

Script Menu

Keyboard equivalent
(Mac: Apple Key +)
(Windows: CTRL Key +) Comments

-------------------------------------------------Go to <this dbase's> Table of Contents
Go to Main Table of Contents
View <this dbase's> Database Notes
-------------------------------------------------First Page
Previous Page
Next Page
Last Page
-------------------------------------------------database-specific scripts go here
.
.
--------------------------------------------------

--------------------------------------1
2
3
--------------------------------------4
5
6
7
--------------------------------------8
9
0
---------------------------------------

---------------------------------------------go to current database's contents
go to main table of contents
view notes on current database
---------------------------------------------jump to the top of a list
move up in a long list
move down in a long list
move to the bottom of a long list
--------------------------------------------additional scripts appropriate to
the current database
.
---------------------------------------------

Only the first ten scripts have keyboard equivalents.
Printing
Typically, printing is done by selecting Print... from the File menu. This will bring up the
standard dialog box and you can select number of copies, page ranges, etc. A few screens,
notably the How-To pages must be printed from buttons; just look for a Print button or notice.
Be aware that different printers have differing print areas and options. Depending on your
printer and default settings, there may be differences between what you see on the screen and
what is printed. Printing from PCs has been tested with only HP & Apple PostScript
laser printers.
See Troubleshooting below if you are having printing problems.
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Selecting Subsets of Data
BIRDD was designed to be a data repository that would allow students or faculty to get a
general idea of the data available so that they could export those data to other software tools. For
this reason, we have not provided sophisticated search or statistical functions, and the various
"View" buttons do not allow users to determine subsets of records, or to select particular
statistics. Some databases do provide Dataset Choice buttons that let you focus displays at
logical subsets of the data.
Faculty are familiar with the statistical and other tools of their trade, and want their students to
learn those tools. We decided to make it easy for BIRDD users to export all records from as
many data sets as possible. Those data can then be imported into the appropriate programs for
analysis of subsets.
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Exporting Data
Many of BIRDD's data can be exported for use in other programs such as spreadsheets and
statistics packages. You can click on an "export" button and save data to a file with the name and
location you specify. In this version, you have no choice of which data fields will be exported.
However, all data analysis programs allow deletion of records and variables, so you can delete
those you do not wish to clutter your analyses.
Data are exported to tab-delimited text files with each record (e.g., a finch specimen or an island)
as a row and each field (e.g., Sex, BeakLength, or island Area) as a column. These are plain text
(ASCII) files whose data values are separated by <tab> characters and rows are ended by
carriage returns. This type of file can be read by most word processors, databases, spreadsheets
and statistics programs.
The first row of an exported file contains the field (column) names; many stat packages have a
setting or option that will import the first row as the label, variable name, or column heading.
Missing data are blank and not coded because different programs a variety of ways of denoting
missing data. If your program requires something else, you may open the file with a text editor
and replace all combinations of <tab><tab> with <tab>missing_value_code<tab>.
The export scripts allow you to specify a file name, destination on the hard disk, and preselects
the "Tab-separated Text" file type option. Users can change any of these settings. Select the
disk, folder and file name you would like to see. Unless you know about specific alternative file
types (e.g., DIF), you will probably find tab-delimited to be the best file format.
As presently implemented, the data that are to be exported are specified and cannot be changed.
Some of the databases contain a large number of fields used internally by scripts and special
layouts that would be confusing for most users. To avoid confusion, we do not allow selection of
subsets of fields or rows. Most statistics and spreadsheet programs make it easy to delete
columns and rows, so we don't expect this to be a major problem. BIRDD exports everything
and you can just delete what you don't need.
At present you cannot export images or sound data. If you need an image, use standard
cut-and-paste methods to move images one at a time (e.g., to NIH Image). Note that images and
sounds are copyrighted and may not be freely distributed. Sound files are available in the
"Raw_Data" folder as either AIFF sound files or MOV QuickTime movie files.
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INSTALLATION & TROUBLESHOOTING NOTES
System Requirements
Macintosh
+ System 7+; 7.1+ recommended
+ 4 MB available RAM
+ QuickTime 3+ to view panoramas
Windows
+ Windows 3.1+; 95+ recommended
+ 8 MB available RAM
+ QuickTime 3+ to view panoramas and play sound files
Both
+ 140 MB free hard disk space
+ color monitor with 800 x 600 or better pixel resolution at 256+ colors

Installation Issues
BIRDD will not run properly from the CD-ROM, it must be installed on each computer's hard
disk.
The best way to install the BIRDD application is to use the BioQUEST Library Online Guide.
The Online Guide is an interactive Adobe Acrobat PDF document that provides access to the
entire contents of The BioQUEST Library. The Online Guide contains a short description of all
of the software applications, text modules, datasets, and tools in the Library, with links to
related documentation and to the module installers.
The Online Guide can be used on either a PC or a Macintosh computer. In order to use the
Online Guide you will need to have the Adobe Acrobat™ Reader installed on your computer.
For best results, we suggest that you install Acrobat™ Reader version 4.0 or later. Installers for
the Acrobat™ Reader version 4.0 for both Macintosh and Windows are included on the Library
CD.
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Notes on BIRDD
To use the Online Guide to install BIRDD:
1. Insert the Library CD that is compatible with your computer system into your computer's
CD drive. If necessary, locate the Acrobat Reader installer on the main level of the CD and
install the Acrobat Reader. Then locate and open the "Online Guide" document. The Online
Guide is located on the main level of The BioQUEST Library CD.
2. To install BIRDD, follow the "Installing a Module" instructions in either the "Quick Start"
section on the Home page of the Guide or in the "Using the Online Guide" section.
Once BIRDD is installed on your hard drive:
3. Check your fonts and monitor settings (next topics).
4. Double-click on the BIRDD (Mac) or BIRDD.EXE (Win) icon or shortcut to start BIRDD.
Fonts
The fonts used in all layouts are Arial, Courier New and Times New Roman. If these fonts are
not installed in your computer, screens and printed pages will be poorly formatted and some
information may be unreadable. All Windows computers and Macintoshes with Microsoft
software will have these fonts already installed. If your computer does not have them, you
should download them from
http://www.microsoft.com/typography/fontpack/default.htm
Scroll down the page and download
Arial.sit.hqx
TimesNew.sit.hqx
CourierNew.sit.hqx
If the above URL doesn't work, go to the Microsoft homepage,
http://www.microsoft.com/
Find the search page and enter the string:
Arial.sit.hqx TimesNew.sit.hqx CourierNew.sit.hqx
then click on All words to find the files.
Your browser should decompress the fonts and you can drag them onto your System Folder
icon.
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Notes on BIRDD
Screen Resolution and Color Depth
The tables-of-contents screens are configured for viewing at 800 x 600 or better resolution. Data
displays typically show pages as they would be printed and are best viewed at higher resolution
(1152 x 870 allows viewing of entire pages without using the Zoom-out control).
On many computers there is a trade-off between higher screen resolution and smaller number of
visible colors. You should choose the highest resolution that provides more than 256 colors.
While 256 colors are acceptible for most of BIRDD's screens, color images are better if you can
display 16--bit color or better (thousands or millions of colors).
Printing
Printing from PCs has been tested with only HP & Apple PostScript laser printers. The most
common problem involves displays, such as tables of contents, that are intended to print in wide
(landscape) orientation will print in tall (portrait) orientation. Similarly, tall displays, such as
notes on databases, may appear as wide. See the "Troubleshooting" note in BIRDD's button,
"Introduction to BIRDD, General Notes".
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Notes on BIRDD
Panoramas And Sounds
Panorama and sound files were created using QuickTime software. Sounds are currently playable
from within BIRDD on a Mac, but not on Windows PCs. Panoramas do not play on either
platform, although one frame of each panorama is visible. We hope to provide an update soon;
check the BioQUEST website (http://www.bioquest.org/birdd) for current information.
There are several ways to play these images:
+ If you own the FileMaker Pro program (Mac version 4+ or Windows version 5+), open
the program and choose Open from the File menu; navigate to the BIRDD folder and select
DFMain.BRD. (Windows users will have to view the contents of the BIRDD folder, then
type DFMAIN.BRD into the filename box.) You can then use the main table of contents just
as if you had double-clicked on the BIRDD icon itself. When you switch to the Vocalization
or the Pictures databases the panoramas and sound should behave as documented in each of
those files. See the How-To buttons in each database for details.
+ If you have QuickTime software installed on your computer, open the folders
shown below and double-click on the appropriate .mov file listed in the information for that
image or sound.
+ If you have other software that plays .mov or .aiff files, you may be able to use it as
described for QuickTime.
The first time you try to view a panorama or listen to a sound, BIRDD may say it can't find a
particular file and ask you to locate it. Take note of its File Location field and navigate to the
appropriate location:
Panorama files are located in the following path:
Mac_BIRDD or PC_BIRD Folder
DFFiles folder
GalPics folder
Pans folder
.mov files

(viewable with QuickTime software)

Sound files are located in the following path:
Mac_BIRDD or PC_BIRD Folder
DFFiles folder
Sounds folder
E_Sounds folder
.mov files
.aiff files
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Notes on BIRDD
File Organization
The files and folders within the BIRDD folder must remain as shown below: Most folders
contain a ReadMe.txt file containing late-breaking news and descriptions of their contents. Slashes
separate files that have different names on Mac & Windows computers
Folder/File
-------------------------Mac_BIRDD/Win_BIRD
BIRDD alias/shortcut
BIRDD_Files:
BIBLIO.BRD
BIRDD/BIRDD.EXE
DFDNA.BRD
DFFiles:
GalImages:
Baltra:
Pans:
StCruz:
CRDS:
Farms:
Finches:
Sounds:

Type
----------folder
file
folder
file
file
file
folder
folder
folder
folder
folder
folder
folder
folder
folder

E_Sounds:
O_Sounds:
DFMAIN.BRD
DFMORPH.BRD
DFTAXA.BRD
DFVOCAL.BRD
GALPICS.BRD
GalTrsts.BRD
GBLines.BRD

folder
folder
file
file
file
file
file
file
file

ISLANDS.BRD
ISL_NAMS.BRD

file
file

MAPS.BRD

file

WEATHER.BRD
file
Documentation:
folder
Documents in MS Word: folder
Feedback Form.pdf
Software Bug Report.pdf
Teaching Resources:
ClassRmExamples.pdf
GettingStarted.pdf
TeachingEvolution.pdf
User_Notes.pdf
Install Info:
ReadMe_BIRDD.pdf

file
file
folder
file
file
file
file
folder
file

Notes
------------------------------------------------------------------------------------holds all of the following
shortcut to the BIRDD application
holds the actual BIRDD databases, sounds and images
bibliography database
application file opened when the alias/shortcut is double-clicked
DNA & protein sequence database
holds image and sound files
holds image files
images from Isla Baltra
panorama files
images from Isla Santa Cruz
images of the Charles Darwin Research Station
images of farms
images of finches
holds sound and other raw data files; .aiff files are audio files readable by
many programs, .mov files are QuickTime files
edited sound files used by the DFVocal database
original, unedited sound files
BIRDD's Main Table ofContents, general introduction and notes
finch morphology database
species database, skull and other species-level images
vocalization database
images of habitats, organisms & locations
tourist fisits database
utility file of molecular sequence data; used by DFDNA database to print
& export data; not directly accesssed by users
island database
utility file of island names; used by other files; not directly accesssed by
users
utility file of map images; used by other files; not directly accesssed by
users
weather database
holds information about BIRDD and feedback forms
holds editable copies of the following Adobe Acrobat (.pdf) files (requires
MS Word or compatible word processor
standard BioQUEST form for providing feedback on BQ modules
standard BioQUEST form for providing bug reports on BQ modules
holds
examples of how BIRDD has been used in a variety of courses
tutorial to help faculty and students get started using BIRDD
brief discussion of issues related to teaching evolution
Adobe Acrobat file containing all of BIRDD's tables of contents,
information notes and "How-To" screens; an off-line manual.
Mac: holds record of installer/setup actions; Win: also uninstall data.
Information on BIRDD installation and late-breaking information

The following files are only needed on Windows computers and are not accessed by users.
CLLNGENU.DLL
FMTOOLS.DLL
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Trouble-shooting
FileMaker Modes
We created BIRDD with FileMaker Pro version 4.0, published by the FileMaker company. We used the FileMaker
Solutions Distribution Kit version 3 to "bind" the databases to the BIRDD stand-alone application. You need not
own the FileMaker Pro application.
FileMaker has a number of features that novices find awkward. Explaining these differences well enough for users
to take advantage of them would, we expect, take time away from the biology that is our goal. Our intent is to
shield FileMaker novices from needing to learn much about FileMaker itself.
New users should look at the "How To Navigate Around BIRDD" screens to learn what to look for. If there is some
confusion about where you are in BIRDD, perssing Apple+1 (Mac) or CTRL+1 (Win) will take you back to the
table of contents for the database you are using and clean up the screen display. If you want more background
understanding, read the rest of this topic; if not, skip to the next one.
FileMaker has three operating modes, one called Layout for changing the structure of the database and views of the
data, and Browse and Preview for viewing data. Layout mode is used by programers and is protected by a
password. Students and instructors will use the other two and there are some inherent advantages and limitations in
each that users should be aware of. See the How-To button on the Main Table of Contents for more details on how
to use the modes.
+ In Browse mode, you can see only individual records (e.g., data on individual finches or islands). The scroll
bars and Status Area Book controls move through the entire database record by record. Most importantly, you
cannot see summary information (e.g., averages for a species). The latter are visible only in Preview mode.
+ Preview mode allows you to see exactly what is going to print on a page, but the horizontal and vertical scroll
bars move only within that single printed page. To see another page you must use the "book" icon in FileMaker's
"status area" on the left of the screen, or the "Next Page" and "Previous Page" script commands.
For consistency, we provide most data displays in Preview mode, since that is required for statistical summaries.
Preview mode does not provide access to buttons or to individual records, so the Table of Contents pages and
How-To pages are presented in Browse mode. This should not be a major limitation as most of the user interface
elements are standard and are covered in pages accessible from the How To Navigate around BIRDD button on the
Main Table of Contents .
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Printing Problems: Text or images are cut off
Pages are too short/wide, or too narrow/tall in screen displays or printouts.
Probable Cause: BIRDD cannot yet work with printer selected in Chooser (Mac) or the default printer
(Windows).
BIRDD will work with the following printers:
Apple and Hewlett Packard (HP) postscript laser printers, many Apple StyleWriters, many HP DeskJet
printers, and many Epson Stylus 740 printers.
Solution: Many postcript laser printers will work with the generic Apple Laserwriter print drivers.
Mac users should open their Chooser and select an appropriate printer icon (e.g., LaserWriter or LaserWriter 8),
select the appropriate printer name and click the Setup button. Click the choice for manually choosing a PPD
file and select Generic from the list. This will often work even if the printer you've selected is an HP or other
postscript device.
Windows user can use a similar strategy: select the printer, use the Properties to select a generic LaserWriter driver.
Solution: If the name of your laser printer does not include the word or string "laser", then rename it to
something that includes the string (without quotes).
Solution: If all of the above fail, you can still do a manual Page/Printer Setup before each print. Note that if you
must do this, How-to pages must be printed one at a time from each page, not by using the Print All button
on the table of contents.
Solution: Contact Frank Price (phone: 315 853-5233, e-mail: fprice@hamilton.edu) for help.
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Panoramas don't work
Probable Cause: These will not work within BIRDD itself and we hope to post updates on the BIRDD website
soon.
Solution: Panoramas and sounds can be played from within QuickTime and some other softwere; see Panoramas
and Sounds topic in the Main database.

Sounds Do not work on Windows PCs
Solution 1: If you have FileMaker (version 4+ for Mac or 5+ for Windows), open BIRDD from
within the FileMaker application:
1. Open your FileMaker application
2. Select "Open Existing File" or if FileMake is already running, select the Open command from the File
menu
3. Navigate or browse to the folder containing BIRDD.
4. Type DFMAIN.BRD into the file name box and click the Open button.
5. At the Main menu, click on the Vocalizations button and play the sounds.
6. If you see a message, "<filename> could not be found and is required...", follow steps a1–a5 above.
Solution 2: If you have QuickTime for Macs or for Windows, or an equivalent program:
1. Note the location and name of the sound and its name in the File Location field on the displays.
2. Switch to your QuickTime Movie Player program (or an equivalent).
3. Use the File > Open command to open the sound file. These are located in
the BIRDD > DFFiles > Sounds > E_Sounds directory.
QuickTime Movie Player controls work as advertised in the vocaliztion database How To screens.

Sounds Do not work on Macs
Probable Cause: On Macs, there is a bug that may cause you to see a message, "<filename>
could not be found and is required..." when you first click on a sound.
Solution 1:
1. Click on the OK button.
2. You will see a message, "Please locate the file..." Click the Cancel button.
4. Click Cancel in response to the continue script message.
5. Click on another sound, it should work, then return to the sound that caused the problem.
Solution 2:
1. Note the name of the file (e.g., Chel.aiff) and click on the OK button.
2. You will see a message, "Please locate the file..." Navigate to the BIRDD > DFFiles > Sounds >
E_Sounds folder.
3. Select the file with the name you noted above and click the Convert button.
4. If you see a message, "This field is not modifiable", click OK.
5. If the sound won't play as described on the following screens, check the volume control and click to
another sound, then back again. You will only have to do this for the first sound in each session.
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VERSION NOTES: 2.0
Modifications To Run On Windows Computers
+
+
+
+
+

All images have been reprocessed to display properly on Windows computers.
Fonts changed from Helvetica and Times to Ariel and Times New Roman, respectively. This
will require that computers have those fonts installed. See Installation Notes
Size of most text was made smaller to fit space available on Windows
Most text objects have vertical alignment set to Center.
Layouts have fixed, 0.5" margins to permit printing on printers with wider non printable
areas.

Other Changes
+
+
+

Numerous changes to make BIRDD more user-friendly: additional error messages,
instructional notes on displays (printed in red text), additional "How-To" pages.
Because BIRDD can export such a large number of different data sets, and because it is so
easy to export data, we have removed the folder of exported data (Exp_Data).
Added BIRDD In The Classroom, a separate text module to help users think about teaching
with BIRDD.

Changes To Individual Data Sets
In addition to minor changes in documentation, internal bibliographies, and various displays, the
following more substantive changes have been made.
Morphology Database:
+
+
+
+

added approx. 6,700 new records from David Lack's studies of Darwin's finches
added Dataset Choice buttons on table of contents to allow views of subsets of data
added diagrams of measurements
added new lists of original and modern taxa names
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Molecular Sequence Database:
+
+
+
+
+
+
+
+
+
+

added over 150 new records from GenBank with sequences of six new molecules
added data from two potential sister taxa
added Dataset Choice buttons on table of contents to allow views of subsets of data
added added summary display of list of molecules & numbers of sequences from each
species
modified display of GenBank records to accommodate longer sequences
added compact synopsis display of each sequence in browse mode for buttons to allow
copying of clean sequences, switching to display of full GenBank record, etc.
added summary listing of primary references with sequences studied.
removed aligned and consensus sequences
removed export of consensus and clean sequences
modified export of GenBank records to allow export of subsets.

Species Database:
+
+
+
+
+

added images of skulls and muscles to species descriptions
added summary views of just skull & muscle images
added notes on skull images with muscles labeled
modified table of islands occupied by each species
added button to allow display of the Islands database's table of species on each island from
within the species database

Vocalization Database:
+
+

modified "How-To" pages
added filename field to vocalization displays

Islands Database:
+
+

added landmarks to Archipelago Landmarks map
added locations where images and panoramas were taken to St. Cruz vegetation zone map.

Weather Database: no changes
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Pictures Database: New
+
+

+

+
+

Provides 12 habitat panoramas and 17 still images of organisms, habitats and landmarks.
Panoramic images can be rotated to see a 360° view of a scene.
Panoramas were created using QuickTime VR software and are not currently viewable from
within BIRDD itself, although one frame of each panorama is visible. The notes in the
database discusses several alternative ways to view these images,
Images may be viewed as small pictures with additional information about the image or as
large images without the additional information. Buttons allow switching between image
sizes.
A button on the table of contents displays a map of Santa Cruz island with the vegetation
zones and the locations of most of the images marked
Images cannot be exported as files, but can be copied-and-pasted using the computer’s
clipboard, or opened from the raw data file.

Bibliography Database: New
+
+
+
+

Contains over 300 references to books, journal articles, audiovisual materials, and Web sites
dealing with Darwin's finches &/or the Galápagos islands.
References may be searched by author, date, title and type.
Citations can be copied individually or exported to text files.
There are extensive notes on how to use BIRDD's find capabilities.

Tourists Database: New
+
+

Contains the number of tourists visiting the islands per month from 1970 through the middle
of 1997.
Data may be viewed as a table or exported to a tab–delimited text file for import into other
software.
Version 1.0

This version of BIRDD is a "first draft" or "prototype" and we plan to make many changes as
time and resources permit. We encourage anyone using it to send feedback and suggestions to
fprice@hamilton.edu. Of course, if you have questions or problems, you should also write.
The user interface and controls are rather simplistic, consisting of buttons and scripts, with little
that users can change. The data are provided "as is" and users cannot change them or add to
them. If you know of other useful data sets, please contact us.
This version has not been tested in multiuser mode. Use in single-user mode only. Use it in
multiuser mode at your own risk, although we would appreciate feedback if you try it.
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The Print command on File menu prints
only this one page. To print all How To
pages, use the Print All "How-To"
Pages button on the Table of Contents

Hint
information

Navigating Around BIRDD:
Tables of Contents

All BIRDD databases have a Table of Contents similar to this one for
BIRDD Itself:

Click for information
about BIRDD,
including contact
information

Beagle Investigations Return Darwinian Data:

About
BIRDD

The D arwin's Finch Data R esource (DFDR)

Main Table of Contents

(version <<gt_Version>>)

+ Click buttons to go to information or data sets.

(boldface buttons are functional)

Red text provides
hints about viewing
and navigating

+ To return to this location from anywhere in BIRDD,

A click here
brought you to
these notes

Click a Return to Main Table of Contents button,

or
Select Go to Main Table of Contents
How To

under the Script menu

Click for
documentation
about the database
Click boldface
buttons to go to
named databases

Click to leave BIRDD

Navigate
Introduction to BIRDD,

Around

Print All

Database Notes

BIRDD

"How To" Pages

Finch Morphology

DNA Sequence

Data

Data

Species

Vocalization

Data

Data

Island

Weather

Pictures &

Data

Data

Panoramas

Quit

Skeletal Data

Protein Data

Bibliography

Click to print all
of these notes
for reference
Plain buttons
are not yet
functional

Tourist

Data

For technical support, comments and suggestions,
contact Frank Price by phone (315) 853-5233 or by e-mail (fprice@hamilton.edu)

Previous

Table
of
Contents

Next

Contact information for support
Buttons to move around among How-to pages
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Navigating Around BIRDD:
Data Windows and Their Controls
Data displayed by a Table of Contents button typically look like printed pages.
Here are the controls you use to manage them.
The "Book" controls which
page is viewed
It appears if there is more than one
page of data Click the top sheet
to page up
Click on the bottom sheet
to page down

Scroll Bars control your
view of a single page
The

Scroll Box ("Thumb")

Data Window

Click in the gray part of the scroll
bar to move one "windowful" in
that direction.

Bookmark
Drag up or down to
move more than one
page at a time (e.g., to
top or bottom page)

Preview/Browse Mode pop-up menu

Scroll Bar are visible only if
part of the data window is not
visible.

1 = current page number
26 = total number of pages

Gray Status Area
& Book appear when
there is more than one
page of data

and gray

Drag the scroll box to the top or
bottom of the scroll bar to jump
to the top or bottom of the
window.
Click the
It the entire data window is
visible, the scroll bar is empty
like this horizontal bar

Scroll arrows to move the
window in that direction.

(use to switch between Preview & Browse modes
see pages 5-7 for more)
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Navigating Around BIRDD:
Menus
Three of the menus are of use within BIRDD
If you select another menu command, the data window may become confusing or empty. If so, select the Go to <db> Table of
Contents Script menu command.
The File Menu allows you to Print many displays and to Quit from BIRDD.
The Mode Menu allows you to shift between browse and preview modes (see pp. 5-7).
The Script Menu allows you to select various information displays Script menu
commands parallel the buttons in the able of Contents. .
´
All databases have

standard script commands and keyboard equivalents:
Keyboard—equivalent commands
<db>
<db>

the Table of Contents for the current database
BIRDD’s main Table of Contents (buttons for different databases)
documentation specific to the current database
first page of current data display (equivalent to dragging bookmark to top)
previous page (equivalent to clicking top page of Book)
next page (equivalent to clicking on bottom page of Book)
last page of current data display (equivalent to dragging bookmark to bottom)
Below standard scripts, each
database has a number of
custom commands
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To print all How To pages, use the Print All
"How-To" Pages button on the Table of
Contents.

Navigating Around BIRDD:
Other Controls

Window size and position are automatic.
You should only use window controls & menus described above.
If you click on another control, esp. the ones marked below in red (gray in print), the data window may become confusing or
even empty. If so, select the Go to <db> Table of Contents Script menu command to clean up the display, then return.
File Edit Mode

Select Format

Script Window

Zoom Box

Layout pop-up menu

Mode pop-up menu
Status Area control

Zoom out control
Zoom in control

FileName
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Resize Box

In some situations, you may wish to use the
the Mode pop-up menu, or the Zoom
controls. See the Next page for more.
page 4

To print all How To pages, use the Print All
"How-To" Pages button on the Table of
Contents.

Navigating Around BIRDD:
Browse vs Preview Modes

Most BIRDD displays are in Preview mode, a few are in Browse mode. Usually, BIRDD sets up displays
correctly, but errors may sometimes lead to the wrong mode.
The left–hand image shows a GenBank display in Browse
mode, the right-hand image shows the same display in
Preview mode. The latter is not appropriate, for printing this
type of record must be done using the Browse-mode button.
Watch for cues shown in red.

Browse Mode Display
Margins not visible

Instructions

Preview Mode Display
Margins visible

Instructions

buttons
not visible

Buttons
visible
Pages

Records

No
Scroll Bar

Preview
Scroll Bar

Browse
FileName

DFMAIN.BRD

page 5

To print all How To pages, use the Print All
"How-To" Pages button on the Table of
Contents.

Navigating Around BIRDD:
Preview Mode

Preview mode is appropriate for viewing data, summary lists & statistics.
In Browse mode these displays look blank. The pictures below show a summary list in both modes.
Browse mode (incorrect: Note that no data are visible and
red instructions show in header.)

Preview mode (correct)

To fix this problem, switch from Browse to Preview: You may 1) Click on the instructions in the
upper left-hand corner, or
2) select Preview from the Mode pop-up
or 3) press
or 4) select Preview from the
Mode menu
U (Mac)
Alt-U (Win)

Use the Zoom-in control to viw images more closely

Use the Zoom-out to fit more on your screen.
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Navigating Around BIRDD:
Browse Mode
Browse mode is appropriate when you need to select items or when buttons are needed.
Examples include these Help pages, all of the Table of Contents displays, GenBank displays (shown on page 4) where a Print
button is needed, and the example below where buttons allow you to copy the sequence and switch between the synopsis and
the full GenBank record.
Browse mode (correct)

Preview mode (incorrect) — Note lack of Buttons,
sequence cannot be selected & copied with the mouse

To fix this problem, switch from Preview to Browse
1) select Browse
from the Mode
pop-up

FileName

or 2) press
B (Mac)
Alt-B (Win)

DFMAIN.BRD

or 3) select
Browse from the Mode menu
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To print all How To pages, use the Print All
"How-To" Pages button on the Table of
Contents.

Navigating Around BIRDD:
Canceling Lengthy Operations

Some operations in BIRDD may take a long time. Where possible, BIRDD will warn you and allow you to cancel the
operation:

If you do continue, lengthy operations are indicated by a
To cancel such an operation, press the

. cursor (Mac) or a flashing esc (Win).

. keys (Mac) or the Esc key (Win)

When you cancel an operation, there are a number of possible results:
1. Everything may look fine, but the number of pages will be replaced by a question mark. You can go ahead and page
through the data, but be careful about printing — some datasets print thousands of pages!
To see how many pages will print, drag the bookmark to the bottom of the book control (see page 2).
If you don't wish to print an entire dataset, enter numbers into the "Print pages from .... to ....." boxes of the Print dialog.

2. The display may be blank. To get back to work, either select Go To Table of Contents from the Script menu, or press
(Mac) or CTRL 1 (Win).
3. If you are still confused, the ultimate fix is to return to the
Main Table of Contents: Select Go to Main Table of Contents from the
Script menu.
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Beagle Investigations Return Darwinian Data: The Darwin's Finch Data Resource (DFDR)
Finch Morphology Table of Contents (version 2.0 [BIRDD v2})
To return to this location:
How To
Interpret
Measurement
Diagrams

Select Go to DFMorph Table of Contents
under the "Script" menu
Morphology DataBase
Notes
List All
Data Sets*

View Samples
From Each Island

Statistics by
Species

Statistics by
Subspecies

List Original Taxa

View All Data on
Each Specimen

Statistics by
Island, Species

Statistics by
Island, Subspecies

List Modern
Species

View Table of
Morphology Data

Statistics by
Species, Island

Statistics by
Subspecies, Island

List Modern
Subspecies
Dataset Choice
Return to
Main Table of Contents

All

Export Selected
Dataset

* This button lists all of the datasets. Other buttons display only data from the subset selected in the
Dataset Choice box. See database Notes.

Notes on Darwin’s Finch Morphology Data
About the Database
The "DFMorph" (Darwin's Finch Morphology) database contains data, mostly morphological (e.g., beak
dimensions), on individual Darwin’s finches. The data are from a number of published and unpublished sources.
Additional information includes the publication, source of the specimen, the original specific or subspecific name
assigned by the author(s), museum location and catalog number, and other information of historical importance.
In particular, Sulloway's (1982) measurements of existing Beagle specimens have been included.
This version contains data from four sources. The first three were in BIRDD version 1, the last is new with
version 2.
+The largest published collection of measurements, taken from Snodgrass & Heller's important early work
(1904).
+Sulloway's historically significant examination of the history of all surviving finch specimens collected by
members of the Beagle expedition (1982).
+Measurements published in Swarth's (1931) monograph.
+Over 6,500 specimens that David Lack measured for his 1945 monograph and 1947 book. Lack deposited copies
of his measurements in the British Museum (Natural History) and the California Academy of Sciences (CAS);
we optioned copies of the latter from the CAS Archives. These more extensive data provide many opportunities
for students to explore variation among individual finches and island populations, and to try to understand how
taxonomists separate specimens into species and subspecies.
There is considerable overlap among these subsets of data. Some specimens, such as those of the Beagle
expedition, may appear in all of them. The Dataset Choice field on the Table of Contents allows you to determine
which set of data to examine and export.
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California Academy of Sciences 21: 1-159.
Lack, D.L. (1947). Darwin's Finches: an essay on the general biological theory of evolution. Cambridge, England,
Cambridge University Press.
Lack, D.L. (1969). “Subspecies and sympatry in Darwin's Finches.” Evolution 23: 252-263.
Snodgrass, R. E. and E. Heller (1904). “Papers from the Hopkins-Stanford Galapagos Expedition, 1898-99 XVI.
Birds.” Proc. Wash. Acad. Sci. 5: 231-372.
Sulloway, F. J. (1982). “The Beagle collections of Darwin's Finches (Geospizinae).” Bulletin of the British
Museum (Natural History), Zoology series 43: 49-94.
Swarth, H. S. (1931). “The avifauna of the Galapagos Islands.” Occ. Pap. Calif. Acad. Sci 18: 5-299.
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Notes on Darwin’s Finch Morphology Data
Notes About the Data
Taxon Names and IDs
The initial confusion and debate over the classification of Darwin's finches settled down in 1931 with Swarth's
monograph. Lack made relatively minor changes (1945, 1947, 1969) and with some exceptions, that is the system
used by most modern workers. We have elected to use Lack's 1969 classification as our standard. Lack's names for
genus and species names plus subspecies if appropriate are the "modern" taxa and are listed with ".L69" at the end
of the field name. In addition, wherever possible we have also recorded the original author's name. See references
and notes in the Species database for more details.
Some of the taxonomic names are lengthy, so we also have a more compact Species.ID as well as a Subspecies.ID
where necessary. The Species.ID is made up of the first 3 letters of Lack's genus, a period, and the first 3 letters of
Lack's species name. For subspecies, a period and the first 3 letters of Lack's subspecies name are added.
For example, the specimens of sharp beaked ground finches on Darwin/Culpepper have the following values:
Field Name
Example Taxon
------------------------------------------------------------------------------------------------Taxon.Original:
Geospiza septentrionalis
Taxon.L69:
Geospiza difficilis septentrionalis
Genus.L69
Geospiza
Species.L69
difficilis
Subspecies.L69
septentrionalis
Species.ID
Geo.dif
Subspecies.ID
Geo.dif.sep
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Notes on Darwin’s Finch Morphology Data
Notes on Data Fields
The terms “beak” and “bill” are used interchangeably.
Here are notes on commonly used data and measurements. Specific definitions and procedures for that source's data
are described later. Click on the Measurement Diagrams button on the Table of Contents to see pictures
summarizing the various measurements.
Attribute
------------------------------Sex

Database Field and Notes
------------------------------------------------------------------Sex
We coded as M, F or U for unknown; a few marked with "?" in originals were
coded as the indicated with the appropriate letter plus "u" for "uncertain", i.e.,
Mu and Fu.

Age

Age
Several authors coded Adult and Juvenile and we had previously accepted their
designation. However, most of those assignments were based on plumage and
the assumption that for, Geospiza at least, black males were adult and
"streaked" or "partially black" males were juvenile. This is now known to be
incorrect, so we no longer export age information.

Plumage

Plumage
Some authors designated Age as "black" or "streaked"; we put these
designations into Plumage.

Wing

Wing.Length

Tail

Tail.Length

Culmen

Upper.Beak.Length
"Culmen" is the technical term; we use a more easily understood, if longer,
term. Note that Lack measured culmen from beak tip "to where it joins the
skull", while Swarth measured "exposed culmen" beyond feathers.
Both of the above differ from "Nostril-to-Maxilla" (Snodgrass & Heller),
"Culmen from Nostril" (Lack) and "Lip of nostril to tip of beak" (Sulloway).
To avoid confusion, these latter are code in the Nostril-Upper.Beak.Length
field.

Gonys

Lower.Beak.Length
Again, a technical term made more easily understood. The lower beak
typically is shaped like a "Y"; the measurement is usually from the fork of the
Y (throat) to the bottom (tip of beak).

Basal Width of Bill

Beak.Width

Basal Depth of Bill

Beak.Height
"Depth" may be interpreted as front–to–back length, so we use "height".

Tarsus

Tarsus.Length
Length of "leg". Actually, the majority of a bird’s leg is a single bone, the
tibiotarsus, that extends from the "ankle" joint to the toes, or phalanges.
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Notes on Darwin’s Finch Morphology Data
+ Sources used a variety of English island names; we display island names in our “Common / English” format.
+ All measurements are in millimeters.
+ There are a number of duplicate museum catalog numbers within the Snodgrass & Heller data, and between the
S&H, Sulloway and Swarth data. The measurements of these birds typically differ because of inherent
variability in the way measurements are are made (e.g., how much pressure is applied to a wing), as well as to
differences in definitions of measurement (e.g., whether culmen is defined as from tip to feathers or from tip to
skull). We have tried to note duplicates in the Notes field for each bird, but left the data as in the original
tables.

Museum Abbreviations
+ Museum abbreviations (mostly used by sources):
BM(NH):
British Museum (Natural History)
Brit Mus:
British Museum
UMZC:
University Museum of Zoology, Cambridge
LRNH:
Leiden Rijksmuseum van Natuurlijke Historie
Stanf. Univ. Mus.
Stanford University Museum
Calif Acad Sci
California Academy of Sciences
U S Nat Mus
United States National Museum
W Johnson
private collection of Captain W. Johnson, of San Francisco

Snodgrass & Heller (549 specimens)
+ Snodgrass & Heller used the following approach to designating subspecies: “Trinomials are applied according
to A. O. U. canons of nomenclature, i.e., when forms overlap in their variations, regardless of the possibility or
impossibility of their interbreeding, they are called subspecies.” (p. 234)
+ All measurements are in millimeters. (p. 235)
+ "Measurements of length are in all cases of the specimen before being skinned." (p. 235) These measurements
must thus have been made in the field and recorded in catalogs or on specimen catalogs. All other sources made
measurements on dried specimens.
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Notes on Darwin’s Finch Morphology Data
Swarth (75 specimens)
+

Swarth made all measurements himself, but did not repeat each measurement. He noted that "extremes were
gone over several times."

+

Age: Originally coded as "black" and "streaked". We originally followed Swarth usage and coded “Adult” for
black and “Juv” for streaked . We have left the data in the database, but no longer export age data (see "Age"
in the table above.

+

Date: We recoded collection date from Mon. Day, Year format to mm/dd/year.

+

Wing Length: measured as the "straight line from bend of closed wing to tip of longest primary, with those
feathers in their natural position (not straightened)." (p. 9) This may differ from Sulloway's and Lack's
"flattened" measurement.

+

Tail Length: measured from "point of insertion of middle rectrices to tip of the longest." (p. 9)

+

Culmen (Upper Beak Length): Measured in a straight line from a point where the feathers cease to hide the
culmen, to tip of maxilla; the chord of the exposed culmen." (p. 9)

+

Depth of Bill at Base (Beak Height): measured from the "base of culmen to angle formed by feathers at
lower edge of ramus of mandible.” (p. 9)

+

Width of Mandible (Beak Width): measured at "base of lower mandible. "(p. 9)

+

Tarsus (Tarsus Length): measured as a "straight line from center of heel joint on posterior side to joint
between metatarsus and middle toe on anterior side.” (p. 9)

+

Middle toe with claw (Middle Toe Length): measured "along upper side, from joint between metatarsus and
middle toe to tip of claw.” (p. 9)

+ Swarth measured a small number of "the type series of Geospiza magnirostris in the British Museum" and
these data are included. There has been considerable confusion over the exact collection locality of Darwin’s and
other Beagle specimens (Sulloway, 1982), so those designations are enclosed in quotes and they should not be
taken at face value. See Sulloway’s records for the best data on the Beagle collections.
+ Swarth provided a number of profiles of individual specimens, mostly natural size. These have been scanned
and included in the dataon each finch.
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Notes on Darwin’s Finch Morphology Data
Sulloway (51 specimens)
Sulloway has studied Darwin’s Galápagos collections and manuscripts and clarified many of the confusing points
that confounded previous workers. In particular, Darwin neglected to record the localities where he collected his
finches. Sulloway tracked down and measured all of the existing Beagle specimens and his (1982) paper is the best
source of data on the Beagle finch collections.
Sulloway tried as much as possible to use Lack’s (1945) methodology in taking measurements:
+ Beak (bill) measurements were made with calipers accurate to better than 0.1 mm (less than typical range of
error in making repeated measurements.
+ Each beak measurement was taken six times on the specimen’s right side; the high and low were discarded and
the remaining four were averaged.
+ Culmen (Nostril-Upper Beak Length): measured from superficial anterior lip of nostril to tip of bill.
+ Depth of Bill: measured from greatest height from base of bottom mandible to top of upper mandible before
the curved culmen begins to descend (i.e., not where mandible meets skull). This may be different from those
of other authors who were less specific about their procedures.
+ Wing Length: measurements were taken from both wings, when present, using a millimeter rule; the flattened
wing was measured from carpal joint to tip of longest primary, to the nearest 0.5 mm. We report only the
measurement of the right wing, unless that wing was missing., in which case we report the left wing.
+ Sulloway’s table reports both the island on the specimen's label and his best determination from other sources
(e.g., field notes, museum catalogues and specimen measurements). We report his best guess in the Island field
and his full report in the record’s Note field. Sulloway presented the label’s locality first followed by a colon.
Where an island name alone follows the colon, Sulloway determined locality on the basis of manuscript
evidence. Where the colon is followed by “island form of subspecies”, the locality was estimated based on “the
specimen’s measurements and plumage, which coincide with only one possible island form, given the various
islands known to have been visited by the collector.
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Notes on Darwin’s Finch Morphology Data
Lack (6,758 specimens)
David Lack's monograph (1945) and book (1947) have had an enormous impact on evolutionary research and his
illustrations have become icons in textbooks. The data in BIRDD are from a copy of his measurements deposited
in the archives of the California Academy of Science.
Here are salient points on Lack’s methodology (1945):
+ Lack specifically tried to exclude specimens that had just left the nest, although he notes that it was impossible
to determine whether they were sexually mature.
+ Lack doesn't state whether he took multiple measurements and averaged them, as Sulloway did. It's clear
however that he tried to assess the reliability of his measurements (see notes below for the Culmen).
+ Beak measurements were made with dial calipers to nearest 0.1 mm.
+ Culmen (Upper Beak Length): measured from the tip of the bill to the place where the culmen joins the
skull. This differed from Swarth's approach and with several species Lack "was unable to estimate accurately the
exact place where the culmen ended on the skull ... measurements of the same specimens taken a month or two
later sometimes gave different results." (1945, p. 75). Unfortunately, Lack appears to have decided to stop
collecting, or tabulating, this measurement. This reduces the comparability of his data with those of earlier
workers.
+ Culmen-From-Nostril: The distance from the anterior edge of the nostril to the tip of the upper beak. This is
the measurement that Lack (and Sulloway) decided to use in place of Swarth's exposed culmen. In his published
work Lack typically used "culmen" to refer to this measurement.
+ Bill Depth (Bill Height): measured at the base, with the bill closed. Some specimens had been stuffed with the
bill slightly open and these were not measured.
+ Wing Length: measured from the carpal joint to the end of the longest primary in the flattened wing; measured
with a millimeter rule to the nearest 1 mm. Note that Lack (and Sulloway) flattened the wing, while Swarth
measured the "wing in natural position."
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Notes on Darwin’s Finch Morphology Data
Exported Data
The export script and button produce a tab-delimited text file with the following column headings:
Field/Column Heading

Comment

--------------------------------------------------------------

------------------------------------------------------------------------------------------------------------------------------

Source
IslandID
TaxonOrig
SpeciesID
SubspID
Sex
Plumage
BodyL
WingL
TailL
BeakW
BeakH
LBeakL
UBeakL
N-UBkL
TarsusL
MToeL

Source of data
Short name of island
Name of taxon assigned by author
Short species name (Gen.spec)
Short subspecies name (Gen.spec.subs)
Sex of specimen
Plumage state
}
}
}
}
} measurements described in Notes About the Data
}
}
}
}
}

--------------------------------------------------------------

------------------------------------------------------------------------------------------------------------------------------

Age is no longer exported (see Notes on Data Fields above).
To avoid duplicate records in exported data, the All dataset cannot be exported. If the Export button is clicked
when All is selected, BIRDD provides an error message.

Miscellaneous Notes
Version History
Version 2.0
+
+
+
+
+
+
+

Lack's data stored at the California Academy of Sciences were added to the database.
Minor changes and corrections were to many layouts.
Added new statistical summaries.
Added buttons and scripts to list data sets and original taxa.
Changed most buttons and scripts to display the data from only one dataset.
Moved Sulloway Upper Beak data to the correct Nostril-Culmen field instead of the incorrect Culmen field.
Modified list of exported data and rearranged columns; removed Age; modified to export data from only one
dataset at a time.
+ Added diagram of measurements
Version 1.1
+ Font and layout changes as covered in notes to Main file
+ All images converted and reimported to work on Windows computers
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Measurements Used by Sources
Upper Beak Length, or "Culmen"
(Lack's method)
(method of Snodgrass &
Heller, Sulloway, Swarth)

Nostril-Upper
Beak Length
Beak
Height

Tarsus
Length
Wing
Length

Middle
Toe &
Claw
Length

Beak
Width

Lower Beak
Length
(Gonys)
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Beagle Investigations Return Darwinian Data: The Darwin’s Finch Data Resource (DFDR)
Finch Molecular Sequence Table of Contents (version 2.0 [BIRDD v2})
To return to this location:
Select Go to Sequence Table of Contents
under the "Script" menu
Sequence
DataBase Notes
View Table of
Sequences & Taxa*
View List of Primary
References*
View Synopsis of
Each Sequence
View Full
GenBank Records
Return to
Main Table of Contents

Dataset Choice
All

Export GenBank
Records

* These buttons list all of the datasets. Other buttons display only data from the subset selected in
the Dataset Choice box. See database Notes.

Notes On The Molecular-Sequence Database
Database Notes
Introduction
This database contains sequences of seven nucleic acids and proteins from 207 individual
finches, representing thirteen species and three (or four) genera. It also includes sequences from 6
individuals of two suggested sister-taxa of Darwin s finches, Coerba flaveola and Tiaris
olivacea.
Viewing the sequence data in this database is relatively uninteresting. However, raw sequences
can be cut and pasted into other programs (e.g., the DNA Electrophoresis program on the
BioQUEST Library CD). GenBank records can also be exported and read by other
DNA—analysis programs.
The data were downloaded from the GenBank Web site (Benson, D. A. et al. 1999):
http://www.ncbi.nlm.nih.gov/
These data were deposited by individual research groups working on a variety of projects (see
Bibliography).
The layout of the Table of Contents display, like that of the Morphology database, differs from
most others in that there is a Dataset Choice box that allows you to determine which subset of
data you wish to view.
The View Table of Sequences & Data button allows you to see a listing of all of the molecules
and species in the database and how many specimens of each are available.
The View Full GenBank Records button displays each complete record. Many of these records
are long enough that they won t fit on a screen, or even a printed page. A scroll bar allows you
to view a complete record. Note that you should not use the regular File > Print command to
print GenBank records, but rather the Print button in the header.
The View Synopsis of Each Sequence button allows you to inspect a summary of information
from each GenBank record. This display is easier to read, although less complete, than the
original GenBank records. Included in this display is the molecular sequence with spaces and
numbers removed. A button will copy this clean sequence to the computer s clipboard from
which it can be copied to other programs.
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Notes On The Molecular-Sequence Database
About the Data
There is considerable variation in how data were entered into GenBank records; this is the
inevitable consequence of the fact that different researchers are entering data on a variety of
macromolecules. In addition, errors were made so that particular entries do not fit GenBank
standards. E.g., fields like DEFINITION and KEYWORDS should contain a period, but some do
not. (NCBI 1999)
The raw GenBank records contain a number of inconsistencies (e.g., scadens instead of
scandens in the DEFINITION field). These do not affect genus or species names in displays or
printouts (except in raw GenBank records.
Also, the REFERENCE fields in GenBank records typically reflect publication status at the time
records are entered into GenBank, often unpublished or in press . We made no attempt to
update these fields, but the Bibliography below groups the GenBank references with actual
publications.
Exporting Sequence Data
GenBank sequences displayed on screen and printed have nucleotide or amino acid numbers
before each line and blanks inserted every 10 characters for readability.
To copy a single sequence without line numbers and blanks for use in programs such as
the DNA Electrophoresis BioQUEST module:
+ Select a dataset to view and click the View Sequence Summaries button. This takes you to a
display in Browse mode where you can inspect individual sequences.
+ Scroll to a specimen you are interested in and click in the Copy This Sequence button.
+ Switch to DNA Electrophoresis or other program and select Paste from the Edit menu (or
press Command+V).
Sequences from multiple finches can be pasted into the Scrap Book, Stickies, or other handy
storage location.
To export GenBank records.
+ Select a dataset in the Dataset Choice box on the Table of Contents.
+ Click the View Full GenBank Records button to verify your choice.
+ Return to the Table of Contents and click the Export GenBank Records button.
+ Type a name for the file to receive the exported records.
+ All of the selected records will be exported to a text file that may be opened with a text
editor or most sequence analysis programs
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Notes On The Molecular-Sequence Database
Version History
Version 2
+ Many new sequences of a variety of molecules added.
+ Aligned and consensus sequences could not be done on the new data, so these fields have been
removed and left as an exercise for the student.
+ Viewing and printing of GenBank data were moved to different layouts because many new
records were so long they have to be printed at small font sizes. These sizes could not be
viewed clearly on many computer screens. Viewing of individual records is now done on a
screen-sized layout in Browse mode and a button has been added to print records with a
full-page sized layout.
+ Because of the new sequences, a Dataset Choice box has been added to the Table of
Contents. You may select any individual molecular sequence or all of them together. The
View Table of Sequences & Taxa button always operates on the entire dataset of sequences
( All ). Other buttons, including Export GenBank Records display, print or export only the
selected dataset.
Version 1.1
+
Font and layout changes as covered in notes to Main file
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Bibliography
Information About GenBank:
Benson, D. A., M.S. Boguski, D.J. Lipman, J. Ostell, B.F.F. Ouellette, B.A. Rapp and D.L..
Wheeler (1999). GenBank. Nucl. Acids Res. 27(1): 12-17.
NCBI, National Center for Biotechnology Information (1999). NCBI-GenBank Flat File
Release 114.0. ftp://ncbi.nlm.nih.gov/genbank/gbrel.txt; visited 12/21/1999.
GenBank Reference (in press):
Freeland ,J. R. and Boag,P.T. Phylogenetics of Darwin’s finches: Paraphyly in the tree finches
and two divergent lineages in the Warbler Finch. Auk (1999) In press
Publication, Related Publications
Freeland, J. R. and P. T. Y. Boag (1999). Phylogenetics of Darwin’s finches: Paraphyly in the
tree-finches, and two divergent lineages in the warbler finch. Auk 116(3): 577-588.
Freeland, J. R. Y. (1997). The genetic evolutionary history of the Darwin’s finches (Aves:
Geospizinae). Ph.D. thesis, Queen’s University, Kingston, Ontario.
Freeland, J. R. and P. T. Y. Boag (1999). The mitochondrial and nuclear genetic homogeneity of
the phenotypically diverse Darwin’s ground finches. Evolution 53(5): 1553-1563.
GenBank Reference:
Petren,K. Microsatellite primers from Geospiza fortis and cross-species amplification in
Darwin’s finches. Mol. Ecol. 7 (12), 1782-1783 (1998)
Other Publications
Petren, K., B. R. Grant, et al. (1999). A phylogeny of Darwin’s finches based on microsatellite
DNA length variation. Proc. R. Soc. Lond. B 266: 321-239.
GenBank Reference:
Sato, A., C. O hUigin, et al. (1999). Phylogeny of Darwin’s finches as revealed by
mitochondrial DNA sequences. Proc. Natl. Acad. Sci. U.S.A. 96(9): 5101-5106.
GenBank Reference (unpublished):
Vincek,V., O’Huigin,C., Satta,Y., Boag,P.T., Grant,P.R., Grant,B.R. and Klein,J. How large was
the founding population of Darwin’s finches. Unpublished
Publication
Vincek, V., C. O’Huigin, et al. (1997). How large was the founding population of Darwin’s
finches? Proc. Royal Soc. London Series B, Biol. Sci. 264(1378): 111-118.
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Contacting GenBank
GenBank
National Center for Biotechnology Information
Bldg. 38A, Rm. 8S-803
8600 Rockville Pike
Bethesda, MD 20894 U.S.A.
Tel: 301-496-2475
Fax: 301-480-9241
http://www.ncbi.nlm.nih.gov/ (NCBI Home Page)
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Beagle Investigations Return Darwinian Data: The Darwin’s Finch Data Resource (DFDR)
Species Table of Contents (version 2.0 [BIRDD v2})
(boldface buttons are functional)
To return to this location:
Select Go to Species Table of Contents
under the "Script" menu
Species
DataBase Notes
View List of
Species Names

View All Data on
Each Species

View Table of
Islands by Species

View Skulls
& Muscles Only

View Table of
Species by Island

View
Ecological Data

Notes on
Skull Images

Print All
Skull Image Notes

View Some
Evolutionary Trees
Return to
Main Table of Contents
Go To Vocalization
Database

Export Species Data

Notes on Finch Taxon Data File
About the Database
This database contains summary data on the taxa (genera, species & subspecies) of Darwin s
finches. Data include species recognition, distribution on islands and general ecology. We have
relatively little on the Cocos Island Finch. This prototype contains only data on species plus a
few notes on genera; data on subspecies may be added later. The data in the Taxa database are
not suitable for export, so this function has not been implemented. Note that the "unit of
observation" in this database is a species; data on individual finches is contained in other
databases such as the morphology and sequences databases.
The taxonomy of Darwin s finches was in considerable flux for over 100 years, so reading the
old (and some new) literature can be quite confusing. Some species can show greater variations
between island populations than there are between species. As Castor and Phillips (1996) note,
Clearly, this fascinating group is in a state of almost visible evolutionary flux, and much further
study is needed.
Summary of Taxonomy
Most modern authors stay close to Lack s scheme (1945, 1947, 1969), which was in turn based
on Swarth s (1931). Lack recognized fourteen species with a total of about 30 distinct
subspecies on the Gal pagos.
Since Swarth s and Lack s work, there has been little disagreement about the delineation of the
14 species, or about their general relationships. There are some debate about a few names, for
example, Sulloway (1982) argued for changing difficilis to nebulosa on historical grounds, but
difficilis is well ensconced in the literature and most modern authors stay with the traditional
name.
The major point of discussion is about genera, especially the genus for pallidus and heliobates.
Genera are rather arbitrary, so this is a point on which reasonable people can disagree. Lack
(1969), followed by Harris (1973, 1983), and others feel that 14 species should not be split into
too many genera; they lump pallidus and heliobates into Camarhynchus. Swarth (1931),
Bowman (1961, 1963) and Grant (1986) feel that pallidus and heliobates are distinctive enough
(e.g., in appearance, ecology and song) and deserve recognition as belonging to their own genus,
Cactospiza (and pallidus becomes pallida for grammatical reasons). At the other end of the
lumper-splitter spectrum, Steadman (1982) would join all 13 Gal pagos species into the single
genus, Geospiza, a practice common among earlier taxonomists (Gould, 1837; Salvin, 1876;
Rothschild and Hartert, 1899; Snodgrass, 1902).
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Here is a summary of the taxonomy used in DFDR:
Genus

Species

Subspecies

Notes

---------------------------------------

--------------------------------

----------------------------------

----------------------------------------------------------

1. Geospiza
(Ground finches)

magnirostris

magnirostris
strenua

2.
3.
4.

fortis
fuliginosa
difficilis

5.

scandens

6.

conirostris

7. Platyspiza
(Vegetarian finch)

crassirostris

8. Camarhynchus
(Tree finches)

psittacula

9.
10.

pauper
parvulus

(subgenus Cactospiza)
11. Camarhynchus

pallidus

12.

heliobates

13. Certhidea
(Warbler finch)

olivacea

14. Pinaroloxias

inornata
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nebulosa
difficilis
debilirostris
septentrionalis
scandens
rothschildi
abingdoni
intermedia
(un-named)

extinct; not used because no other living
subspecies
extinct

Lack (1969) suggests one additional island
population may be sub-specifically distinct but
hasn t been formally described.

conirostris
propinqua
darwini

psittacula
affinis
habeli
parvulus
salvini
pallidus
productus
striatipectus

Lack lumps pallidus & heliobates in
Camarhynchus, but recognizes that
they are less closely related to the
Tree finches. Some authors designate
Cactospiza as a full genus.

olivacea
bifasciata
luteola
ridgwayi
fusca
cinerascens
becki
mentalis
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Notes About the Data
Finch Status On Islands
This table may be confusing as it attempts to present the data on which islands each species
inhabits as compactly as possible. Summary of numbers of islands are next to the species
noame; data for each species appear in two rows: in the top row are the data for major islands,
and data for minor islands are in the second row. Island names are shown in compact ID form.
The codes are as follows:
B known to breed regularly on the island, well documented by several sources
p possibly breeds on the island &/or sources disagree
o known to occasionally breed on the island
s believed to have been collected on island, probably not a resident
x known to breed in past, but now extinct
To summarize the distribution, we have also totaled the number of islands for each species as:
breeding, uncertain (p + o + s) and extinct.
Miscellaneous Notes
Version History
Version 2.0
+ List of species & subspecies revised slightly and expanded to subspecies.
+ AKA list expanded to include more synonyms, but is still incomplete.
+ Added images of lateral and ventral skulls w/ muscles and beak cross sections.
+ Added counts of number of islands where breeding, where uncertain and where extinct.
+ Revised Status on Island display, added number of islands counts.
Version 1.1
+ Font and layout changes as covered in notes to Main file
+ All images converted and reimported to work on Windows computers. See notes in Main
file
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Geospizine Taxon Information:
Skull Structure: Lateral View of Skull & Muscles

Geospiza magnirostris

M. add. post.

M. add. ext. sup.

M. pter. d. lat.

M. add. ext. prof.
M. depr. mand.

mandibular
rhamphotheca

Lig. jugomand. art.
Proc.
palatomax.

Lig. jugomand. ext.
M. add. post.
M. pter. v. lat.
M. add. ext. med.

M. add. ext. sup.

Superficial jaw muscles
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Geospizine Taxon Information:
Skull Structure: Ventral View of Skull & Muscles
Geospiza fortis

Right side:
superficial jaw muscles

Proc. palato-max.

mandibular
rhamphotheca

Proc. transpal.

Left Side:
deep jaw muscles

M. pseudotemp prof.
M. pter. v. lat.
M. add. ext. med.
M. pter. v. med.

M. pter. d. lat.
pterygoid
M. pter. d. med.

M. pter. v. lat.

Lig. jugomand. art.

M. depr. mand.

M. retr. pal.

Certhidea olivacea

M. pseudotemp prof.

M. pter. v. med.

M. pter. d. lat.
M. pter. d. med.
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Geospizine Taxon Information:
Abbreviations of Skull Structures
Abbreviation

Definition

Lig. jugomand. art.
Lig. jugomand. ext.

Jugomandibular Articular Ligament
Jugomandibular Externus Ligament

M. add. ext. med.
M. add. ext. prof.
M. add. ext. sup.

Adductor Mandibulae Externus Muscle, Partes Medialis
Adductor Mandibulae Externus Muscle, Partes Profundus
Adductor Mandibulae Externus Muscle, Partes Superficialis

M. add. post.

Adductor Mandibulae Posterior Muscle

M. depr. mand.

Depressor Mandibulae Muscle

M. pseudotemp prof.

Pseudotemporalis Superficialis Profundus Muscle

M. pter. d. lat.
M. pter. d. med.

Pterygoideus Dorsalis Muscle, Partes Lateralis
Pterygoideus Dorsalis Muscle, Partes Medialis

M. pter. v. lat.
M. pter. v. med.

Pterygoideus Ventralis Muscle, Partes Lateralis
Pterygoideus Ventralis Muscle, Partes Medialis

M. retr. pal.

Retractor Palatini

Mandibular Rhamphotheca horny, keratinized covering of beak
Proc. palato-max.

Palato-Maxillary Process

Proc. transpal.

Transpalatus Process

Pterygoid

Pterygoid Bone
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Geospizine Taxon Information:
Skull Structure: Palate
Generalized Ventral View of Palate
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Names Used in the Darwin’s Finch Data Resource
Species.ID Taxon

Common.Name

AKA.Name

Cam.hel

Camarhynchus heliobates Mangrove F.

Cactospiza heliobates

Cam.pal

Camarhynchus pallidus

Woodpecker F.

Cactospiza pallidus; Cactornis
pallidus;
pallidus (Sclater & Salvin);
striatipectus (Swarth)

Cam.par

Camarhynchus parvulus

Small Tree F.

Geospiza parvula (Gould);
salvini (Ridgway)

Cam.pau

Camarhynchus pauper

Medium Tree F.

Cam.psi

Camarhynchus psittacula Large Tree F.

Cer.oli

Certhidea olivacea

Warbler F.

becki (Rothschild); mentalis
(Ridgway; fusca (Sclater &
Salvin); olivacea (Gould);
bifasciata (Ridgway); luteola
(Ridgway); cinerascens
(Ridgway); ridgwayi (Rothschild
& hartert)

Geo.con

Geospiza conirostris

Large Cactus F.

darwini (Rothschild & Hartert);
propinqua (Ridgway);
conirostris (Ridgway)

Geo.dif

Geospiza difficilis

Sharp-beaked Ground nebulosa (Gould);
F.
septentrionalis (Rothschild &
Hartert); difficilis (Sharpe);
debilirostris (Ridgway)

Geo.for

Geospiza fortis

Medium Ground F.

Geo.ful

Geospiza fuliginosa

Small Ground F.

Geo.mag

Geospiza magnirostris

Large Ground F.

strenua (Gould)

Geo.sca

Geospiza scandens

Cactus Ground F.

Cactornis scandens

Pin.ino

Pinaroloxias inornata

Cocos F.

Pla.cra

Platyspiza crassirostris

Vegetarian F.
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Summary Table of Ecological Data
Camarhynchus heliobates

Mangrove F.

Length 14.0 cm

Wt

18 g

No. Islands
Breed Uncertain Extinct

2
Food
larg insects, mangrove
leaves
Camarhynchus pallidus

Foraging.Method
pecking, probing, occ.
uses twig
Woodpecker F.

Foraging.Habitat
mangrove swamps

Length 15.2 cm

Foraging.Location
tree trunks, branches

Wt

20 g

Camarhynchus parvulus

Foraging.Method
pecking, probing; uses
spines, twigs

Small Tree F.

Foraging.Habitat
Miconia & Scalesia,
transition, arid coastal

Length 11.4 cm

Foraging.Location
tree trunks, large
branches

Wt

13 g

No. Islands
Breed Uncertain Extinct

Camarhynchus pauper

Foraging.Method
shallow excavation,
hangs upside-down

Medium Tree F.

Foraging.Habitat
commonest in Scalesia,
transition; some arid

Length 12.7 cm

Foraging.Location
tips of small branches,
twigs more on ground
than other Cam.
Wt

16 g
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Foraging.Method
medium excavation?

Foraging.Habitat

Foraging.Location

0

No. Islands
Breed Uncertain Extinct

0

0

Breeding.Habitat

No. Islands
Breed Uncertain Extinct

1
Food
little known (between
Cam.psi &
Cam.par?)

1

Breeding.Habitat
commonly in Miconia
& Scalesia zones, less
often in arid zone

9
Food
variety of ismall
nsects, fruits, soft
seeds

0

Breeding.Habitat
mangrove swamps

5
Food
large insects, often
hidden; some fruit

0

0

0

Breeding.Habitat
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Summary Table of Ecological Data
Camarhynchus psittacula

Large Tree F.

Length 12.7 cm

Wt

18 g

No. Islands
Breed Uncertain Extinct

9
Food
variety of large insects

Certhidea olivacea

Foraging.Method
deep excavation,
twisting bill

Foraging.Habitat
moist zones, rarely arid

Warbler F.

Length 10.2 cm

Foraging.Location
larger branches, twigs

Wt

8g

insects

Geospiza conirostris

Foraging.Method
pick from surface, occ.
“fly-catch” on wing

Foraging.Habitat
all zones, mostly
Scalesia, Miconia
zones

Large Cactus F.

Length 15.2 cm

Foraging.Location
trees, bushes

Wt

28 g

No. Islands
Breed Uncertain Extinct

Geospiza difficilis

Foraging.Method
scratch ground, peck
from plant

Foraging.Habitat
arid zone

Sharp-beaked Ground F.

Length 12.7 cm

Foraging.Location
more open ground than
G. scandens; digs
gravel, moves stones
Wt

20 g
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Foraging.Method
scratch ground, pick
from plant; pecks large
birds, drinks blood

Foraging.Habitat
humid on central isls;
arid on N. isls

Foraging.Location
mostly on ground;

0

No. Islands
Breed Uncertain Extinct

0

0

Breeding.Habitat

No. Islands
Breed Uncertain Extinct

7
Food
little known, soft
seeds, insects, flowers

0

Breeding.Habitat

5
Food
soft, medium-hard
seeds, large insects,
fruit, nectar, pulp

1

Breeding.Habitat

17
Food

1

0

3

Breeding.Habitat
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Summary Table of Ecological Data
Geospiza fortis

Medium Ground F.

Length 12.7 cm

Wt

20 g

No. Islands
Breed Uncertain Extinct

16
Food
various medium-hard
seeds; few insects
Geospiza fuliginosa

Foraging.Method
scratch ground, peck
from plant
Small Ground F.

Foraging.Habitat
all zones, commonest
in arid
Length 11.4 cm

Foraging.Location
mostly on ground;

Wt

14 g

Geospiza magnirostris

Foraging.Method
scratch ground, peck
from plant

Large Ground F.

Foraging.Habitat
all zones; common in
humid on central isls,
arid on N. isls
Length 16.5 cm

Foraging.Location
plants, ground; ticks on
tortoises, iguanas

Wt

35 g

No. Islands
Breed Uncertain Extinct

Geospiza scandens

Foraging.Method
scratch ground, peck
from plant
Cactus Ground F.

Foraging.Habitat
arid zone

Length 14.0 cm

Foraging.Location
more in trees, shrubs,
less on ground
Wt

21 g
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Foraging.Method
scratch ground, peck
from plant

Foraging.Habitat
arid zone

Foraging.Location
usu. in cactus

0

No. Islands
Breed Uncertain Extinct

2

1

Breeding.Habitat

No. Islands
Breed Uncertain Extinct

14
Food
medium-hard seeds;
fruit,nectar, pulp esp.
Opuntia cactus

2

Breeding.Habitat

11
Food
very hard seeds, usu.
large; few insects

0

Breeding.Habitat
lowlands, not highlands

27
Food
various soft, small
seeds; insects; flowers,
fruit

1

0

0

Breeding.Habitat
Opuntia (Prickly Pear
Cactus)
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Summary Table of Ecological Data
Pinaroloxias inornata

Cocos F.

Length

No. Islands
Breed Uncertain Extinct

Wt

1
Food
little known, probably
insects, nectar, fruit
Platyspiza crassirostris

Foraging.Method
little known, probably
pecking
Vegetarian F.

Foraging.Habitat
tropical rainforests

Length 16.5 cm

Foraging.Location
among leaves, on
ground
Wt

34 g
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Foraging.Method
peck from plant

Foraging.Habitat
transition zone, occ.
arid coastal & Scalesia

Foraging.Location
trees, bushes;
occasionally ground

0

Breeding.Habitat

No. Islands
Breed Uncertain Extinct

9
Food
fleshy fruits; soft-,
medium-hard seeds;
leaves, flowers

0

1

0

Breeding.Habitat
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Beagle Investigations Return Darwinian Data: The Darwin’s Finch Data Resource (DFDR)
Finch Vocalizations Table of Contents (version 2.0 [BIRDD v2})
(boldface buttons are functional)
To return to this location:
Select Go to DFVocal Table of Contents
under the "Script" menu
Vocalization
DataBase Notes

How to
Play &
Interpret
Sounds

Print All
"How-To"
Pages

Vocalizations &
Descriptions
Vocalizations
& Components
Compare
Vocalizations

Return to
Main Table of Contents
Go To Species
Database

Export data

Notes On The Vocalization Database
About the Database
This database differs from others because of the nature of the data: sounds require different
controls. Moreover, there are pictures sonograms and waveform displays that can help you
analyze sounds, but which are probably unfamiliar.
Be sure to click on the How Play & Interpret Sounds button on the Table of Contents, and
perhaps print the help pages.
In order to play sounds, the program must be in Browse mode, not Preview mode (see Help
screens in Main Table of Contents). This means that this database performs somewhat
differently from other DFDR databases. In particular, the Next and Previous Page commands, as
well as the Book pages, move from one record (i.e., vocalization) to another. In other databases,
these commands and controls move from one printed page to another.
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Notes On The Vocalization Database
Background
Vocalizations, especially courtship/territorial songs, are common isolating mechanisms between
species in organisms such as crickets, frogs and birds. This database contains a few examples of
songs and calls of Darwin’s finches.
The definitive work to date on vocal repertoires of Darwin’s finches is a massive 300-page chapter
by Bowman (1983). It contains a wealth of detail that we cannot hope to approach. Bowman
documented a variety of species-specific vocalizations, differing patterns within and between
populations of one species on different islands, as well as differences associated with differing
motivational states, social situation and habitat. While this database contains only a one or two
samples from a limited number of species, it will let you examine the sounds visually and aurally.
We have also included Harris’ (1982) and Castro and Phillips’ (1996) descriptions of each
species’ vocalizations to allow you to compare the limitations of textual descriptions to more
informative images and sounds.
Bowman categorized three basic types of vocalizations, each with a number of variations:
+“Whistle song” — a long continuous “hissssssssss” or “seeeeeeeeee”, or a series of short
notes (“see-see-see-see...”) that start at very high frequencies (often inaudible to humans) and
descend gradually or rapidly to lower, more audible frequencies. This is produced during the
breeding season and is structured to make it hard for predators like owls and hawks to locate.
+“Basic song” — has three variants:
“Basic song” proper — has syllables like “chicago”, with a drown-out, buzzy “a”, as in
“chic-a.a.a.a.a.a.a.go”. This is used in territorial defense and advertisement.
“Special Basic song” — consists of a drawn-out, raspy “bizzzzzz” that Bowman characterizes
as ‘a high-pitched “growl.”’
“Abbreviate basic song” — is a shortened form of the basic song in which the extended middle
buzz is shortened, as in “ree-search, ree-search”.
+“Derived song” — has two variants:
a polysyllabic form, e.g., “tee-you, tee-you” or “chee-tee, chee-tee”.
a monosyllabic form, e.g., “churr-churr-churr-chur.
Variations occurred within and between populations of one species and between different species.
Some populations “borrowed” calls from other species. Harris (1982) noted that “the range of
variation within any one population is greater than the differences between species. Also there are
considerable inter-island differences in song.” Clearly, identifying species by songs alone is only
for the very experienced.
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Notes On The Vocalization Database
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Notes About the Data
Data Sources
The vocalizations in this database were provided by the Library of Natural Sounds at the Cornell
Laboratory of Ornithology. Waveform and sonogram images were produced using the “Canary”
software program developed by the Bioacoustics Research Program, also at the Lab of
Ornithology. Additional information on these fine organizations and their resources can be found
at the following locations:
Library of Natural Sounds
http://www.ornith.cornell.edu/LNS/LNS.htm
Bioacoustics Research Program (BRP) http://www.ornith.cornell.edu/brp/brp.htm
Cornell Laboratory of Ornithology
159 Sapsucker Woods Road
Ithaca, NY 14850-1999

http://www.ornith.cornell.edu/
(607) 254-BIRD = (607) 254-2473

All sounds are copyrighted by the Cornell Laboratory of Ornithology. Unless you obtain
permission from the Laboratory, you may not use or reproduce these sound except in the course of
using this database for educational, noncommercial purposes.
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Notes On The Vocalization Database
Sound Files and Formats
Raw sound files were provided by the Library of Natural Sounds on CD in audio CD format. Each
sound was converted to a Macintosh sound file (44.1 kHz sampling rate, 16-bit amplitude
resolution, monaural) using the SimpleSound application and saved as QuickTime movie (.mov)
files. These files are available in the original sounds (O_Sounds) folder in the Raw_Data folder.
Files were opened with Canary, edited to remove verbal introductions, long stretches of silence, and
some noise, then saved in the edited sounds (E_Sounds) folder as .aiff files. These are the sounds
used to generate waveform and sonogram images, and are played from within the database. Edited
sounds are saved in .aiff-format files in the Edited Sounds (E_Sounds) folder inside the Raw_Data
folder.
Note: these .aiff files and their enclosing folders must remain within the DFDR: Raw_Data:
E_Sounds series of folders or the sounds cannot be played.
Problems Hearing Sounds?
Sounds are not currently playable from within BIRDD itself, although one image is visible. We
hope to provide an update soon; check the BioQUEST website (http://www.bioquest.org) for
current information.
There are several ways to play these sounds; click the Information button in the Main Table of
Contents and scroll down to the section on Panoramas and Sounds.
On some Windows machines and some Macs, you may have to use a separate sound application,
e.g., QuickTime, to play the sound files outside of BIRDD.
If you still have problems hearing sounds. Make sure the Sound (or Monitors and Sound) control
panel is configured properly, and especially that the the volume control is turned up.
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Problems With Sounds
This database of sounds is something of a rough draft; we expect future versions to be much improved. In
particular, sounds are not playable on a Windows computer.
On Macs, there is a bug that may cause you to see a message, "<filename> could not be found and is
required..." when you first click on a sound.
1. Note the name of the file (e.g., Chel.aiff) and click on the OK button.
2. You will see a message, "Please locate the file..." Navigate to the BIRDD > DFFiles > Sounds > E_Sounds folder.
3. Select the file with the name you noted above and click the Convert button.
4. If you see a message, "This field is not modifiable", click OK.
5. If the sound won't play as described on the following screens, check the volume control and click to another
sound, then back again. You will only have to do this for the first sound in each session.
If you have FileMaker (version 4+ for Mac or version 5+ for Windows), you can open BIRDD from within the
FileMaker application. Here’s how:
1. Open your FileMaker application
2. Select "Open Existing File" or if FileMake is already running, select the Open command from the File menu
3. Navigate or browse to the folder containing BIRDD.
4. Type DFMAIN.BRD into the file name box and click the Open button.
5. At the Main menu, click on the Vocalizations button and play the sounds.
6. If you see a message, "<filename> could not be found and is required...", follow steps 1–5 above.
If you choose to listen with QuickTime for Macs or for Windows, or an equivalent program:
1. Note the location and name of the sound and its name in the File Location
field on the displays.
2. Switch to your QuickTime Movie Player program (or an equivalent).
3. Use the File > Open command to open the sound file. These are located in
the BIRDD > DFFiles > Sounds > E_Sounds directory.
QuickTime Movie Player controls work as advertised in the next screens.
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Controlling Sound Playback
When you click on a picture of a sound, a standard QuickTime playback
control bar will appear nearby, as shown below.
Click anywhere in
this sound picture
to activate
its QuickTime
control

Slider
Play/Stop Button
Speaker/volume Control

Forward & Reverse
Frame-advance Buttons (don t
work with sounds)

+ To start or stop the recording: click the Play/Stop button (or press the space bar). The slider will move along the
picture as the sound plays. Although not perfectly synchronized, the slider s position along the picture will roughly
correspond to the sound.
+ To adjust the sound level: click on the Speaker/Volume control. (You may also need to adjust your computer s
Sound Control Panel; consult the user s manual for your computer, or contact your user support organization.)
+ Tip: To move the slider to a particular part of the recording, click on that spot. During playback , clicking on a spot
will return the playback to that point and repeat from there.

File Name: DFVOCAL.BR

p. 1

Pictorial Displays

Sonogram Display: Graphs
sound frequency, or pitch,
on the vertical axis and time
on the horizontal axis.
Pitch/frequency is measured
in kHz (kilohertz, thousands
of cycles per second).

Waveform Display: Graphs
sound pressure roughly,
loudness on the vertical
axis and time on the
horizontal axis.
Sound pressure is measured
in Pa (micropascals).

For both displays, time is
measured in seconds (s) or
milliseconds (ms).
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Interpreting Pictorial Displays
Annotated Sonogram & Waveform Displays

Notes

1

2

3

1

2

3

4

5

2 4

5

6

6.a 2

4

5

6.b 3a 4 2

4
5 42 4
5
6 6.a 2 4
5
6.b 3a 4 2
See notes with corresponding numbers below.

1. Three-notes of the basic song
2. Silence: a splice where recording was shortened.
3. Whistles: start as a faint, high mark on sonogram that rapidly descends in frequency and becomes stronger.
a. The louder call, indicated by the taller trace on the waveform and the darker sonogram trace.
4. White noise or static from wind, other background noises, and the recording apparatus. The louder this background
noise, the broader the fuzzy band on the waveform and the darker the gray background in the sonogram.
5. The basic song: a series of three quick, low-pitched chur or tur sounds followed by a fourth.
6. Chip a very brief sound with a broad frequency range.
a. Softest chip: shown by the short spike on the waveform trace and faint
sonogram trace.
b. Loudest chip: shown by the taller spike and darker sonogram.
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Beagle Investigations Return Darwinian Data: The Darwin’s Finch Data Resource (DFDR)
Island Table of Contents (version 2.0 [BIRDD v2})
To return to this location:
Select Go to Islands Table of Contents
under the "Script" menu
Islands
DataBase Notes
View Archipelago
Maps

View All Data on
Each Island

View Map of
Vegetation Zones

View
Island Summaries

Finches Inhabiting
Each Island

Islands Inhabited
By Each Species

View All Island
Names
View Islands’
Vegetation Zones
Return to
Main Table of Contents

Export Island
Data

Notes on Island Database
About the Database
This data file contains information about individual islands. Data on area, species of plants, etc. can
help provide ideas for students' study of the finch distributions.
Maps can be printed for reference and the blank map can be copied and used to draw species
distribution, etc. Map images can be pasted into programs like NIH Image (available on the
BioQUEST Library CD-ROM) for additional manipulation — to measure topographic diversity,
for example.
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Notes on Island Database
Notes About the Data
Elevation Data
There are considerable differences in published measurements (up to more than 100 m in some
cases). Most elevations in m were read from the DMA map. For a few low islands with no
elevation indicated on the DMA map, elevations from Healy are shown as highest contour line
followed by a “+”. A few data were taken from M. Jackson (1993).
Island Areas
Areas were measured using NIH Image to select islands on 300 dpi images scanned from the
DMA map. Extraneous symbols and numbers that touched island outlines were removed, the
default Threshold command was used, then the “wand” tool was used to select the outside of the
island outline. The “Measure” command computed the area inside the outline as well as the
outline. The outline itself makes up a significant proportion of the area on small islands. Assuming
the middle of an outline is the “actual” border of the island, our procedure overestimates island
area. However, it is at least consistent . We know of no other source of data for all of the islands
and published sources vary significantly.
Ages of Islands
Ages, measured in millions of years, were taken from the maximum values listed in Cox (1983)
Finch Breeding Status
Species were tabulated from Grant (1986), Harris (1973, 1982), Lack (1947, 1969). In general, a
species was recorded only if at least two different authors agreed on its status. For some of the
minor islands, Grant (1986) was the only author to mention the island; in these cases, his data were
used.
Vegetation Zones
Data were compiled from Bowman (1961) and Harris (1982). Question marks indicate areas of
disagreement
Exported Data
The export script and button produce a text file with the following data fields:
Field/Column Heading
-------------------------------Isl.ID
Island.Name
Area.km
Elev.m
Age
No.Ferns
No.FlPlants
No.LandBirds
No.Finches
Zone.Mangrove
Zone.Arid
Zone.Transition
Zone.Scalesia
Zone.Miconia
Zone.Grassy

file: Islands

Comments
----------------------------------------------------Short Island ID code
Long Common / English name
Area of island in square kilometers
Maximum elevation of island in meters
Maximum age of island in millions of years
Number of species of ferns
Number of species of flowering plants
Number of species of land birds
Number of species of Darwin's finches breeding
}
} <blank> = zone not present on island
}
X
= zone present on island
}
?
= zone possibly present on island
}
= no zone data available for island
}
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Galápagos Archipelago: Islands
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Galápagos Archipelago: Landmarks
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Galápagos Archipelago: Blank
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Map of Vegetation Zones on Santa Cruz Island
Ferry Landing
Upper Transition
Lower Transition
Pit Crater

Cerro Media Luna

Bellavista, farm

Lava tube
Charles Darwin Research Station
Puerto Ayora

Bahía Tortuga

Grassy: Drier; fern, grass, sedge summit grassland (<1 m high)
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Scalesia: Closed-canopy evergreen forest dominated by
“Humid” “garúa”
Scalesia (12-20 m)
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Transition: Open-canopy, semi-deciduous woodland, xerophytic
misty rain)
trees growing higher than cacti (7-9 m)
Arid Coastal: dry; tree-like cactus forest (≈ 4 m high) & scrub
Coastal Zone: salt-tolerant shrubs, saltbush; mangroves in low, sheltered bays
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Galapagos Archipelago: Summary of Island Names
Isl_ID

Common / English

Alb
Balt_SS
Brto_Brth
Bgle
Cldw
Cmp
Cocos
Cwly
DMaj
DMin
Drwn_Clp
Edn
Endrb
Esp_Hd
Frn_Nrb
Flor_Chrl
Grd_EsHd
Grd_FlCh
Gnov_Twr
GFwak
Isa_Alb
Plazas
LHrm_Crsm
Mrch_Bndl
Pnt_Abng
Pnz_Dnc
Pitt
Rab_Jrv
RcaPat
RcaRed
Bainb
SCris_Chat
SCru_Inde

Albany
Baltra/S.Seymour
Bartolomé/Bartholomew
Beagle
Caldwell
Campeón/Champion
Cocos
Cowley
Daphne Major
Daphne Minor
Darwin/Culpepper
Edén
Enderby
Española/Hood
Fernandina/Narborough
Floreana/Charles
Gardner (Esp/Hood)
Gardner (Flor/Charles)
Genovesa/Tower
Guy Fawkes
Isabela/Albemarle
Islas Plazas
Los Hermanos/Crossman
Marchena/Bindloe
Pinta/Abingdon
Pinzón/Duncan
Pitt
Rábida/Jervis
Roca Pateadora
Roca Redonda
Rocas Bainbridge/Bainbridge
Rocks
San Cristóbal/Chatham
Santa Cruz/Indefatigable

SFe_Brngt
Snti_Jams
Seym_NS
SNmb_Nmls
Trtu_Brat
Watson
Wlf_Wnm

Santa Fé/Barrington
Santiago/James
Seymour /N. Seymour
Sin Nombre/Nameless
Tortuga/Brattle
Watson
Wolf/Wenman
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Official

Other Names

Baltra
Bartolomé
Beagle

Seymour Sur

Campéon
Cocos
Cowley
Daphne Major
Darwin
Edén
Enderby
Española
Fenandina
Santa María

Guerra

Genovesa

Ewres

Isabella
Plaza
Los Hermanos
Marchena
Pinta
Pinzón

Santa Gertrudis

Plata

Torres
Geraldino
Dean

Rábida

San Cristóbal
Santa Cruz
Santa Fé
San Salvador
Seymour Norte
Sin Nombre
Tortuga
Wolf

Dassigney, Grande
Bolivia, Norfolk, Porter, Valdez, Cháves, San
Clemente
Olmedo, Gil, York

Nuñez, Gasna, Genovesa, Ewres
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Finch Status* on Islands

Isl_ID

No.
Cam. Cam. Cam. Cam. Cam. Cer. Geo. Geo. Geo. Geo. Geo. Geo. Plat. Species
hel. pal. par. pau. psit. oliv. coni. diff. fort. fuli. mag. scan. cras. Breeding
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s
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B
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s=straggler
x=bred
in
past,
now
extinct
Clone.fp3

10

4
page 1

Beagle Investigations Return Darwinian Data: The Darwin’s Finch Data Resource (DFDR)
Weather Table of Contents (version 2.0 [BIRDD v2})
To return to this location:
Select Go to Weather Table of Contents
under the "Script" menu
Weather
DataBase Notes
View All
Weather Data
View Rainfall Data
1950-1989

Graph 1950-1989
Monthly Rainfall

View Avg Rainfall
1950-1989

Export 1950-1989
Monthly RainFall

View Monthly
Stats by Location

Export Monthly
Statistics

Return to
Main Table of Contents

Notes on Weather Data
About the Database
This database contains a variety of weather data. The major data include:
+ 40 Years’ (1950-89) Data on Rainfall on San Cristóbal. These data may be
viewed as raw data or, more usefully, exported for summarizing and analysis in other
programs. These data are also summarized by month. The average rainfall is reported in
both the Rainfall field (for consistency with other sources and in the AvgRain field (unique
to the NOAA/BQ data).
+ Monthly averages from a variety of sources. These data are taken from sources
that are not consistent, but do reflect the difficulty of comparisons.

Notes About the Data
+ Monthly precipitation on San Crist bal from 1950-1989.
NOAA (1997). United States National Oceanic and Atmospheric Administration,
National Climatic Data Center, Global Historical Climatology Network: Precipitation
Data (V1). URL: http://www.ncdc.noaa.gov/ghcn/ghcnV1.CLIMVIS.html
(visited 4 Dec. 1997).
**Note:** This dataset is not for commercial distribution. Those countries’ data
summaries and products which are available at this site are intended for free and
unrestricted use in research, education, and other noncommercial activities. However, for
non-U.S. locations’ data, the data or any derived product shall not be provided to other
users or be used for the re-export of commercial services.
+ Forty-year Average Monthly Precipitation on San Crist bal (1950-1989). Data are
from the above source, NOAA (1997), but have been summarized as part of this project
and the source listed as NOAA/BQ . Run the View 1950-89 Rainfall Monthly
statistics script to see this summary.
+ Six-year Averages (1965-70) of Meteorological Readings by Charles Darwin
Research Station. Data are from:
Harris, M. P. (1982). A Field Guide to Birds of Gal pagos. London, Collins.
+ Average Monthly Precipitation and Temperature at 10 Galapagos Locations. Data
are from: Hoffmann, J. A. J. (1975). Atlas climatico de America del Sur : mapas de
temperaturas y precipitaciones medias (Climatic atlas of South America: maps of mean
temperature and precipitation), World Meteorological Organization, UNESCO
Cartographia. Unfortunately, the time frame of the data used to generate the monthly
averages were not reported, so the Years were coded as Unk .

FileName
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Notes on Weather Data
Exported Monthly Rainfall data
Exporting the 1950-1989 rainfall data produces a tab-delimited text file with the following data:
Field/Column Heading
-------------------------Island.ID
Location
Year
Month
Year.Month
Rain(mm)

Comment
-----------------------------------------------------------The short name of the island
The name of the weather station location
The 4-digit year
The 1 or 2 digit month
The decimal equivalent of the middle of the month, i.e.,
((month/12) + 0.5). This facilitates graphing the “date”
The total rainfall that month in mm.

Exported Monthly Average data
Exporting the average stats data produces a tab-delimited text file with the following data:
Field/Column Heading
-------------------------Data.Source
Island.ID
Location
Year
Month
Elev
AvgMaxTemp
AvgMinTemp
AvgTemp
SeaTemp
HrsSun
Rain(mm)

Comment
-----------------------------------------------------------Name of source of data
Short name of Island
Name of location of weather station
4-digit year or year range, if known
1 or 2 digit month
Elevation of weather station in meters
}
}
} appropriate statistic; temperatures in °C
}
}
}

Procedure used to retrieve NOAA data
Point Web browser to: http://www.ncdc.noaa.gov/ghcn/ghcnV1.CLIMVIS.html
Select Graph Type: “Graph precipitation for the entire period of record”
Select Region: click on South America
Select a country or station group: click on “Ecuador” in country list
Click “Okay “button .
Select a station: click “1950 to 1989 SAN CRISTOBAL (GALA, 0.90S 89.6W”
Click “Okay” button.
Select metric units button, click “Graph Period of Record” button
Click “View the Dataset” button.
Use browser’s File>Save command to save data to disk file.
Comparable temperature data were not available.
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Notes on Weather Data
Bibliography
NOAA (1997). United States National Oceanic and Atmospheric Administration, National
Climatic Data Center, Global Historical Climatology Network: Precipitation Data (V1).
URL: http://www.ncdc.noaa.gov/ghcn/ghcnV1.CLIMVIS.html
(visited 4 Dec. 1997).
Note: monthly summaries of these data were prepared by BioQUEST members. These
summary data are noted as NOAA/BQ in the Source field.
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Monthly Rainfall 1950-1989 on San Cristóbal
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Beagle Investigations Return Darwinian Data: The Darwin's Finch Data Resource (DFDR)
Galápagos Pictures Table of Contents (version 1.0 [BIRDD v2})
(boldface buttons are functional)
To return to this location:
Select Go to Picture Table of Contents
under the "Script" menu
Image
Database Notes
Map of Image
Locations, Habitats

View Habitat
Panoramas

All Images (small)
& Information

View Still Images

How to
Use
Panoramas

Print All
"How-To"
Pages

All Images (large)

Return to
Main Table of Contents

Export data

Notes On The Image Database
About the Database
INTRODUCTION
This database contains a number of pictures of Galápagos habitats, organisms and data, including
panoramic images that allow you to rotate to see a 360° view of a scene. Current keyword and
search capabilities are crude, but will be refined in future versions.
You may view images either as small pictures with additional information about the image or as
large images without the additional information. Buttons allow you to switch between image
sizes.
The Map of Image Locations, Habitats button will show you a map of Santa Cruz island with
the vegetation zones and the locations of most of the images marked.

PANORAMAS
Panoramas were created using QuickTime VR software. These are not currently viewable from
within BIRDD itself, although one frame of each panorama is visible. We hope to provide an
update soon; check the BioQUEST website (http://www.bioquest.org) for current information.
There are several ways to play these images, click the How To Use Panoramas button on the
Table of Contents for this database. You may also click on the Information button in the Main
Table of Contents and scroll down to the section on Panoramas and Sounds.

EXPORTING IMAGES
Images cannot be exported as files, but you may copy-and-paste images through your
computer’s clipboard. Select the appropriate image and use the Copy command on the Edit
menu.

Field Notes
Most of these images were taken by Alicia Newton & Janna Pistiner, students from Colgate
University in Hamilton, NY. Their field notes are attached to these database notes and provide
modern students's reactions to some of the realities of field research in the Galápagos.
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Notes About the Data
Field Notes
by
Alicia Newton & Janna Pistiner
Colgate University, Hamilton, NY

Over this summer (August, 1999), we, Alicia Newton and Janna Pistiner, undergraduate students
at Colgate University, were given the opportunity to go to the Galapagos Islands and visually
document the different vegetation zones found on the islands. The Galapagos, and especially
Santa Cruz Island presented an interesting location to do research. Besides being incredibly
remote, Santa Cruz Island proved to have completely unpredictable weather, unpredictable
wildlife, and plenty of completely unpredictable situations.
We began to prepare for our photography experience back at Colgate. Over the course of three to
four weeks, we researched vegetation zones on the Galapagos Islands, as well poring over
countless maps and pictures, trying to find the best places to get the pictures we were looking for.
We also had to find time to learn how to use our digital camera, as well as the computer programs
that would store the pictures we took, and stitch them into digital panoramas, computerized images
that allow a viewer to see a full 360° view of an area.
After a few days of intensive camera and computer training, we felt ready to handle at least the
technical aspect of our job. We were unsure on exactly where we should be taking pictures,
however. While we were able to find many articles and web sites detailing the different zones, as
well as the different vegetation and wildlife we would find in them, we were rarely able to locate
anything that could tell us where we should be taking pictures. We knew we were limited to Santa
Cruz Island, due to the difficulty of transportation between islands. We also knew that the six
zones that were represented on that island were all due to elevation. But as to exact elevation, or
places that we could access at that elevation, we were lost. We, along with our advisors Karen
Harpp and Frank Price, decided it would be best to get to Santa Cruz Island, home of the Darwin
Research Station, and ask the scientists working there for advice.
Sunday, 8/1/99
And so before we knew it, August 1, 1999 came around, and we found ourselves on a plane
(actually many planes) to Quito, Ecuador.
The first obstacle came in getting to the island itself. After a number of connecting flights, and a
few frantic runs through airports, we found ourselves in Quito, Ecuador, in the middle of the
night. We managed to find taxis, and after a few interesting wrong turns, we arrived at the hostel
that would be our home for the next few days while we worked out logistics with the Darwin
Station.
Wednesday, 8/4/99
Finally it was time to venture to the Galapagos. From the Quito National Airport, we flew onto
Baltra Island, a small island within sight of Santa Cruz. From there we loaded our rather large
amount of equipment onto a bus and headed for the Baltra dock. From there we took a boat
across the rather small channel to Santa Cruz. Once on Santa Cruz, a pick-up truck from the
Darwin Station picked us up and brought us to the other side of the island.
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One of the hardest aspects of travelling so much was the amount of equipment we had to bring. In
addition to the camera, tripod, and computer we needed for our work, we were travelling with a
group of students and professors heading to Genovesa Island to do their own geologic research.
Professor Karen Harpp and student Dan Korich of Colgate, Professor Carl Wirth and student
Bryan Kennedy, and student Daniel Andrade of Escuela Politecnica Nacional of Ecuador were
planning to spend ten days on the small island mapping and collecting rock samples as part of a
separate project on the origins of the Galapagos Islands. As a result, we were also carrying a
number of bags containing sampling equipment, mapping tools, and all the gear that would be
needed to spend a week and a half on an uninhabited island. So all the equipment, as well as two
members of our group, were loaded onto the back of the pick-up, and we set off for the Darwin
Station.
After about fifty minutes of travel, across paved and gravel roads, we found ourselves in Puerto
Ayora, the main town both on the island of Santa Cruz, and the Galapagos Islands as a whole.
Because of a large number of visiting scientists, the dormitories that the Station has to rent were
full. As a result we ended up in the Castro Hotel, as small family-run establishment about a mile
from the Darwin Station. Janna and I settled into our room that we would call home for the next
week, while the other members of the group prepared to leave for Genovesa sometime within the
next three days.
Our first goal upon arriving that Wednesday was to try and find places to take pictures. So we set
off to find anyone in the station who could help us. After asking for directions in the Station
library, we made our way to the Botany building, located about fifty feet from the library. We, in
our limited Spanish, managed to ask if anyone knew someone who may be able to help us. Two
helpful station volunteers introduced us to Mark, an Australian botanist who knew the island well.
He gave us a list of places that would offer the best representation of the vegetation zones. Now
we just needed to find out how to get there.
Thursday, 8/5/99
On Thursday, our search finally led us to Sarah, a Canadian masters student whose specialty
happened to be introduced grasses is the highlands (or the uppermost area of the volcano). After
talking to her, we learned that by venturing into the highlands, we would be able to get excellent
panoramas of both the Miconia Zone (located at Media Luna, a half crater on the side of the
volcano) and the Pampa (Fern Sedge) Zone (located at Cerro Crocker, the highest point of the
volcano). She was going up to the highlands the following Monday, she said. Would we like to
come along? Not knowing completely what we were getting into, we agreed. We would meet her
outside our hotel Monday at 6:00 A.M..
In the meantime, we decided to search for the perfect panorama of the Arid Zone, the zone in
which the station and the town were located. The same helpful volunteers that took us to Mark led
us to the water tower located a five minute hike from the Botany building. So, in our slightly
improving Spanish, we talked with the volunteers, learning more about the island, and the places
we would want to visit and photograph.
Because the center of the water tower had a large pole in the center, we weren't able to set up the
tripod to get a picture that didn't include the pole. Our only option appeared to be setting up the
tripod head on top of the already existing pole, with the help of some string and a lot of duct tape.
But after this improvisation we had our first true panorama, which we dutifully stitched on our
computer and saved on a few Zip disks. We showed off our panorama to the rest of our group,
then waved good-bye as they left for Genovesa, leaving us on our own for the next ten days.
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Saturday, 8/7/99
In addition to the vegetation zones, we were told to take panoramas of anything interesting,
anything related to geology or even life in the town that would visually represent what the island
was like. We decided that lava tubes would be an interesting subject to photograph. So, after
reading an article in the library, we rented mountain bikes and headed in the general direction the
article gave us. After an extremely difficult fifteen minute ride up the side of the mountain in the
mist called garúagarúa with all our camera equipment, we came across the lava tubes. We
ventured inside and, despite some slick rocks, were able to take a wonderful panorama showing
the characteristic levels marks, skylights, and collapses of the lava tubes, which form as the lava
on the outside of a flow hardens while the lava inside continues to flow through, until finally the
molten rock runs out, leaving the tube to drain. From there we biked up hill some more, until we
finally reached the small town of Bellavista, home of some of the largest accessible lava tubes on
Santa Cruz. Bellavista is a small town located about ten kilometers from Puerto Ayora.
We finally got to the 7.5km long tunnel with the help of some friendly town residents. A kindly
older man who spoke very rapid Spanish ran the tunnel entrance. We were finally able to
communicate that we wanted to go through it to take pictures, at which point he showed us the
large hand painted diagram of the tunnel, and the collapse through which we were to emerge,
about 2.5km into the tube. We were a bit skeptical (and we had no idea where on the surface of
the island we would emerge) but the man handed us an extra flashlight in case ours died, and we
were on our way. We entered the tunnel, and quickly realized why he had given us the extra
flashlight. Once we had gotten a few hundred meters from the large entrance, there was no light
other than our rather weak flashlight. It was the darkest dark imaginable, and the silence was
amazing. We were the only people in the tube, and soon decided that it might be best to turn
around. So we headed back out of the cave, returned our flashlight, and headed back to our hotel
room.
We set up our computer to copy the pictures from the camera to the computer (a rather long
process on a laptop) and went to dinner at the Station. When we returned forty-five minutes later,
we saved the files on the computer and cleared them from the camera, in order to save space on the
valuable picture cards. We then went to sleep to prepare to take a panorama of the coastal zone the
next day.
Sunday, 8/8/99
When we woke up, the sun was shining, and we thought it would be a great time to head to
Tortuga Bay, the best place to photograph the mangrove trees that are so characteristic of the
coastal zone. By the time we had walked the 2.5 km to the beach from our hotel, it had begun to
get cloudy. This was our first introduction to the power of the garúa, the strange weather pattern
that would dictate our lives for the next week. Garúa is a driving mist common to the islands that
have higher elevations during, ironically, the dry season. As the moist air moves off the ocean
and up into the higher elevations, it cools, resulting in an intense mist that results in constant
clouds, mist, and humidity.
By the time we had set up our tripod, it was hazy and beginning to mist. We attempted to wait it
out, but after about an hour and a half, decided it probably wouldn't clear up. We decided to
return to the station for the day to work on our other task of finding articles and pictures on and of
the smaller, more remote islands. After completing some work in the library, we returned to our
hotel to try to stitch our lava tube pictures into a panorama.
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It was then that we discovered our computer wouldn't turn on. The garúa and constant humidity
had already proven to be too much for out little laptop to handle. We spent the rest of the night
talking to various people and trying to find out what options we had. Almost all the pictures we
had already taken were lost, with the exception the water
tower panorama. We spent most of the night trying to figure out what we should do about saving
pictures, and having enough memory for all the pictures we planned to take. At about 9 P.M. we
realized that we were going to be going to the highlands for eleven hours the next day, and we
ought to bring something to eat with us. Unfortunately, it was 9 P.M. on a Sunday night. We
ended up with two oranges, four pieces of bread, and a small pineapple.
Monday, 8/9/99
So Monday morning came and we got into the same pick-up truck that brought us to the station
and went off past Bellavista to the beginning of the trail to Media Luna and Cerro Crocker. On the
way to the trail we began to experience more and more garúa as we climbed in elevation. When
we got to the trail, the mist had let up, but the ground was soaked. So the three of us began to
climb up to the highest point. At one branching of the trail, Sarah pointed out the trail to Media
Luna and Cerro Crocker, then headed off to her area of introduced grasses. We asked if we
should use our Global Positioning System, but she assured us that there was no way we could get
off the trail, or get lost. She would meet us in eight hours, in the spot where we were standing.
So we were on our own. We continued to climb, and the garúa began to pick up again, along
with driving winds. We continued to climb upward, until finally we reached the highest point.
We were soaked. The rain was a fine mist being blown forcefully at us from every direction. The
mist was so fine that it quickly blew through our jeans and rain jackets. When we had asked
Sarah about what to wear, she had forgot to mention the true amount of rain we would face. So
there we were, at the top of the mountain, soaked, and in the middle of a rain storm. We couldn't
take out the digital camera in that much rain, so we decided to head back down the volcano, and
hope that eventually the rain would stop. After slipping down the incredible muddy trails that slid
beneath our feet, we reached a point that would make a great panorama. Having prepared so
thoroughly for the rain, we got out the umbrella. We quickly realized that it seemed as though the
rain was coming up the slope. So eventually we tried to guard the camera from the rain as best we
could during a pause in the downpour.
After that adventure, we decided to head to Media Luna. We climbed up and down along the
muddy paths, falling a number of times, all the while carrying our equipment. Our brief respite
from the garúa was followed by a harder mist, but with fewer winds. Finally we came upon a
casita, or guard station that Sarah said marked the edge of the Miconia Zone. We sat on the edge
of the porch, and ate the last of our bread. It was 10 A.M.. Hearing our voices, one of the men
inside of the casita came out. Seeing the state we were in, he invited us into the casita with him
and his coworker to warm up and dry off. In halting Spanish we explained our goal to the two
men, pest control agents working for the nation park service. They took pity on us and gave us
coffee, offering to let us stay as long as we wanted. We warmed up for about ten minutes, then
headed out to get our pictures.
It had stopped raining at that point allowing us to get a nice panorama of the Miconia Zone. But
even without the rain, it seemed like there was constant condensation. Thus the Wiper Method, in
which after every picture, one of us would try to find a somewhat dry piece of clothing to wipe the
water droplets of the camera lens. We then decided to head back, even though we had about five
hours before we were to meet Sarah.
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We followed the path past the guard house, and continued down to what appeared to be a branch
in the path. We weren't sure exactly which path to take, but, using our somewhat basic compass
skills, decided that we knew which path headed in the right direction, and decided to take it. We
walked for almost twenty minutes without recognizing anything, and without not recognizing
anything. Finally, we began to head up again, and we came to a pipeline that we knew we hadn't
passed. We decided it would be best to turn around.
Twenty minutes later we came to the same branch, and took the other path. At this point, we
weren't really sure we recognized anything. So we kept walking, hoping that the fact we were
walking with the water current that was streaming down the path under our feet meant that if
nothing else we were heading down in elevation.
Finally we came to a rise. Fearing that this meant we were again heading up the volcano, we
stopped. We were hungry and cold, still soaked from the early morning rain. We had the
pineapple and the pocket knife. So, with few other options, we half cut and half ripped the
pineapple open, chewing violently though the juicy fruit. Pineapple strands stuck in out teeth, and
our cheeks stung from the acidic juice, but we didn't care. So after our "meal," we headed up the
rise, to find ourselves looking at the road we came in on, as well as Bellavista. We gratefully slid
down the muddy path, careful only not to hit the barbed wire fences of the farms that lined the
road.
On our way into Bellavista we met up with the guards, who we walked with into town. When we
got into town, they signaled a pick-up, and we were given a ride back to Puerto Ayora and the
Station. We then walked back through town (covered in the mud from Media Luna) until we
reached our rooms and collapsed.
Tuesday, 8/10/99
Bright and early Tuesday morning, we gathered up all of our gear and said farewell to the Castro
Hotel. After getting situated in our temporary Darwin Research Station abode, we set out for the
tortoise pens. Our initial mission was to obtain a panorama of our large shelled friends. So, we
positioned ourselves in the middle of the pen and set up our tripod. Just as we finished leveling
the camera, a group of tourists flooded in and surrounded us. We decided to wait it out and try to
take the panorama right after they left. As the group started wandering away, all of the tortoises
started charging our equipment. Despite popular belief, we discovered that tortoises can move
those stumpy wrinkled legs of theirs pretty fast.
Mistaking our yellow camera bag for their usual banana treats, the tortoises scurried towards us.
We would move and set up the equipment, just in time for the tortoises to come towards us again.
When we finally figured out that the colorful bag was luring them in, another tour group poured
into the pen. We covered everything yellow that we could find and decided not to give up. With
some patience, we thought that we could out-sit the influx of eco-tourists. So there we sat and
sat. It was hopeless! After about two hours, we settled for a half of a panorama and some cute
tortoise action shots.
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Following lunch at the station, we went out to attempt to take our panorama of Tortuga Bay. With
our gear on backs and digital photos on our minds, we set out for the bay, again. The narrow
path ran up and down, through the arid flora. Although the sky started out as its hazey-garúa best,
it became increasingly cold and dark as we neared our coastal destination. Turn around? No way!
We had already done this once before - to leave without a panorama again would be such a waste
of our short time on the island. Onward we walked. When we could finally see ocean, it began to
drizzle. So, sit it out, we decided. There we sat and sat (the unlucky theme of our day), waiting
for the sky to clear. We wanted to get the incredibly gorgeous bay at its finest. Unfortunately, the
sky became darker and darker. We returned to the station that night panorama-less, hopeful that
our excursions-to-come would be more successful.
Wednesday, 8/11/99: Lava Tunnel, Farms, Lower Transition, Upper
Transition, Birds, Dock, Los Gemalos
After a quick station breakfast, we set out for a cross-island day trip. Abandoning our bad, gear
induced bruised-bum biking idea, we arranged to have a driver take us to different locations on
Santa Cruz. The driver seemed really nice, but could not understand any English and had
difficulty deciphering our broken Spanish. Luckily, Tuan, an American Peace Corps volunteer
accompanied us, serving as our translator and guide. Tuan was definitely up for a chuck-full day
of panoramas and exploration. Our driver, on the other hand, did not seem to welcome the
prospect of a siesta-less day without a warm lunch until we bought him some chocolate bars at the
Puerto Ayora grocery store. Since he napped in the truck at each site, we didn't worry too much
about him being sleep deprived. Following our food stop, we went to the lava tunnel to retake the
panorama that was lost when the computer crashed.
We crept back into the tunnel, and spun the camera one more time. Once finished, we jumped
back into the red pick-up to visit some farms that Tuan had worked on for a sustainable agriculture
Peace Corps project. The farms were incredible. It seemed like every imaginable fruit and
vegetable was growing on each plot of land. goyaba trees were dispersed between orange trees
and pineapples grew across from the coffee. Guava, pera, peppers, tomatoes, beans, papaya and
mango were everywhere! The daughter of the man who owned the farm was giving us a taste of
every fruit imaginable. We twisted open the long brown goyaba bean and ate out the white fruit
from around the seed. The red, pera was like a cross between an apple and a pear. All of it was
delicious!
We sampled everything that we could plunge our teeth into before looking at the green houses. It
was interesting to see the plastic-covered sheds of vegetables. In addition, it was strange to see
cows, goats, dogs and chickens roaming around. There were so many introduced species of flora
and fauna. It raised many conservation issues in our minds. Visiting the farms on Santa Cruz
allowed us to see the grave affects of human impact on the Galapagos Islands.
Next, we set off for the lower transition zone. Driving along the road, it was very difficult to
differentiate the zones of vegetation. In addition to the prescence of introduced species, the
limitations of our equipment made it difficult to find an appropriate site. After numerous "here?'s"
and "I don't know"s, we settled on a spot a few meters away from the main road. The dense,
low-lying brush made it difficult to set up the equipment. So, we jumped around and stomped on
the surrounding vegetation. After guiltfully clearing an ample circumference for ourselves, we
took the shots.
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Then, we journey to the other side of the island. As we drove over the peak of the volcano, the
dense garúa faded into blue skies and sunshine. The leeward side was absolutely beautiful! The
Scalescia trees were larger and the shrubbery was lower. Therefore, it was easy to pick a spot
right off the road to jump out and take the pictures. In order to get a panorama minus the big red
pick-up truck, the driver zoomed away for a while. When we walked back to the truck, Baltra
was in clear view.
Near by, Blue-footed Boobies had a break from Frigate theft. The Frigates were much too
preoccupied. A group of fishermen had just returned with their catch. Frigates and cranes
swarmed overhead in anticipation of some fresh seafood. At the same time, a new load of tourists
came across from Baltra. After watching the activity at the dock, we decided to head back to get
the final images for the day.
On the way back towards Puerto Ayora, we stopped at Los Gemalos, the twin pit craters. Tourist
buses came and went as we took pictures of the tremendous craters. Tuan pointed out an avocado
plant that sticks out of the very center of the pit. This introduced tree seemed to peak out of
nowhere. Obscured by the thick mist, the craters looked fantastically surreal. Hesitant that the
pictures would no do the striking scene justice, we wanted to wait out what we thought was
merely bad weather. We thought that we could wait out the worst of the misty garúa surrounded
us. The driver told us otherwise. In that case, he told us, we'd be there the whole summer. He
advised us to just take the picture since the air didn't get much clearer through the "dry season."
Taking his advice, we took the pictures and then stood gasping at the impressive size of the craters
for a while.
Then, we were station-bound after a successful day of tubes, craters and vegetation panoramas.
We located the different zones and made the best of what summer weather on the Galapagos could
give us!
Thursday , 8/12/99
This was it. We had every vegetation zone except for the coastal zone, despite our two previous
trips. So we decided to grab our gear and head to Tortuga Bay. The sun was shining, and there
didn't seem to be a cloud in the sky, but we knew how quickly that could change. We walked as
fast as we could, especially considering the amount of equipment we were carrying. When we
arrived at the beach, it had gotten slightly overcast, but no rain in sight. We quickly hurried to the
spot we had decided to take our panorama at the first time we visited.
Once there, we learned it was a popular spot. A group of eighth graders on a class trip from Quito
were playing, and a family had decided to picnic on the beach. Considering the rather nice
weather, we decided to wait. After about thirty minutes, the school group had moved on, after
leaving some designs in the sand, and the only people in our way were the family. We finally
asked them if they wouldn't mind moving for a few moments. We then ended up explaining our
project, and showed them everything about the digital camera. They were happy to help us out,
and even amused when we realized that a picture of one of their towels was in a mangrove picture.
We were done! It as a relief to realize we had accomplished everything we had hoped to. We
decided to celebrate by going to the restaurant at the Hotel Sol y Mar for tea. The Sol y Mar also
had a patio on the ocean, home to a number of marine iguanas and crabs, as well as blue footed
boobies and pelicans. We decided that it would be nice to have a visual documentation of a lot of
the wildlife as well as the vegetation.
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After our lunch, we headed to the office of Howard and Heidi Snell, the administrators of the
Darwin Station, who had agreed to help us with our computer troubles. After a discussion, we
decided that the best approach would be to leave our picture cards with them, so they could copy
them onto zip disks. Relieved, we decided to head back to our room and organize all the data we
had collected.
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If Panoramas Don’t Work
This database of pictures is something of a rough draft; we expect future versions to be much improved. In
particular, the panoramas are not currently viewable from within BIRDD itself, although one frame of each
panorama is visible.
We hope to provide an update soon; check the BioQUEST website (http://www.bioquest.org) for current
information.
There are several alternative ways to play these images,
If you have FileMaker (version 4+ for Mac or version 5+ for Windows), you can open BIRDD from within the
FileMaker application:
1. Open your FileMaker application
2. Select Open Existing File or if FileMake is already running select the Open command from the File menu
3. Navigate or browse to the folder containing BIRDD.
4. Type DFMAIN.BRD into the file name box and click the Open button.
5. At the Main menu, click on the Pictures and Panoramas button and view the panoramas.
If you choose to listen with QuickTime for Macs or for Windows, or an equivalent program:
1. Note the location of the image and its name in the File Location field on the displays.
2. Switch to your QuickTime Movie Player program (or an equivalent).
3. Use the File > Open command to open the panorama file. These are located in the BIRDD > DFFiles > GalImages
> Pans directory.
QuickTime Movie Player controls work as advertised in the next screen.
For more informaton: click the Information button in the Main Table of Contents and go to the section on Panoramas
and Sounds.
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Controlling Panoramas
When you click on a picture panorama image, a standard QuickTime
playback control bar will appear, as shown below. (This image is inactive.)
Cylinder Rotates

Click anywhere in
this picture
image
out of
frame

visible frame
of image.

image
out of
frame

to activate

its QuickTime
control
(inactive)
Zoom-Out button
Zoom-In Button
(inactive)

QuickTime panoramas are essentially windows looking out toward a cylindrical image.
The mouse cursor turns into a bull s eye; if you hold the mouse button down on the image, it becomes an arrow. If you
move the mouse while holding down the button, the cylinder will rotate to show more of the image in that direction. The
image will move left or right and up or down as you move the mouse.
The faster & farther you move the mouse, the faster the cylinder will rotate.
Click on the zoom buttons to bring the image closer or farther.
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Notes on Bibliography Database
About the Database
INTRODUCTION
This database contains over 300 references to literature and World Wide Web sites on the
Gal pagos and on Darwin s finches. This is a preliminary version of a more full-fledged
bibliography we hope to provide in a future edition of BIRDD.
Bibliographic databases are complex and while a number of them are available as stand-alone
programs (e.g, EndNote“ and ProCite“), we hope however to provide significant
functionality from within BIRDD so users do not need to buy additional software.

FINDING REFERENCES
This database required somewhat more sophisticated search capabilities than other BIRDD
databases, so we have provided extensive notes under the How To Find References button on
the Table of Contents. Be sure to read over those pages before trying to use the Find
References button to do searches.
We would appreciate feedback from faculty and students on how we might improve this
database and especially the search feature.

VIEWING/BROWSING REFERENCES
When you do a search or click on the View All References button, you will see the Listing of
References display in Browse mode. Browse mode is appropriate for this display because it
allows you to use the buttons described below. (Refer to the Navigating button on the Main
Table of Contents for more on Preview and Browse modes.)
Go To Table of Contents Button
Returns to the Table of Contents.
Another Find Button
Allows you do return to do another search of the database without going through the Table
of Contents.
Copy One Selected Record Button
If you have clicked to select a particular reference, this will copy the text of the reference to
your computer s clipboard and you can paste it into a word processor or other document.
You may then print your list of references as part of a report or to take to your library
shelves.
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Export Found Records Button
Creates a text file with all of the references in it. You can give the new file a name and
determine where on your computer s hard drive the file is placed. The file can be opened by
a word processor or any other file that can read text files.
Preview Pages Button
Most of the listings of references are shown in Browse mode so you can use the various
buttons. If you want to see what the printed pages will look like and how many there will
be, click this button to go to Preview mode. You may return to Browse mode and see the
buttons by selecting Browse from the Mode menu, or from the Mode pop-up menu.

EXPORTING REFERENCES
Exporting is done from the Export Found References in the Listing of References display.
Each citation is exported as a single line of text, with hard returns between lines/citations.
Additional formatting can be done with the word processor or other program that you use to
manipulate the exported file.
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How to Find References:
The Find Screen
Clicking the Find References button on the Table of Contents brings up The Find Screen:
Click to add, delete and
move between criteria

Click to find references
meeting the criteria

Search Criteria are like data
records. You may type entries
into one or more search
"requests." The book icon
shows the number of requests
(2 in this example) and which
request is active (2nd).

Click to cancel and return
to the Table of Contents

Type criteria into fields.

OMIT/NOT and Symbol
Controls.
2nd request
(black bar on left & visible
field outlines indicate this
request is the active one)
Do not use these controls

Once the criteria have
been entered, click the
Perform Find button.
Most of the fields are just text boxes that
you can type in. The Reference Type field,
however, provides a list for you to select
from
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How to Find References:
Simple Searches for a Single Criterion
Find criteria can be complex, but many finds are simple:
Any single value entered into a field will retrieve references with that value.
Examples:
darwin

darwin’s finch

Retrieves works with Darwin in the Author field

Retrieves works with darwin’s & finch in the title

1990

web
Retrieves all web sites in the database.
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How to Find References:
Special Symbols
A number of special symbols can make criteria more flexible:
<
<=

Less than
Less than or equal

>
>=

Greater than
Greater than or equal

=

Exact match

==

Entire field

@

1 character

*

...

Range

1 or more characters

"text"

Exact text

Examples:
< 1900
Published before 1900

>= 1900
Published during or after 1900

1850 ... 1900
Published between 1850 and
1900 (inclusive)

FileName

Published in 1890, 1990

Smith

=Smith

Smith, Smithson, Smithers ...

Smith but not Smithson or Smithers
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How to Find References:
Special Symbols (cont.)
<
<=
=
@
...

Less than
Less than or equal
Exact match
1 character
Range

>
>=
==

*
"text"

Greater than
Greater than or equal
Entire field
1 or more characters
Exact text

More Examples:
Grant, P. R.

“Grant, P. R.”

Grant and initials R. and P. anywhere
among authors (96 in this database)

Grant, P. R. and any other authors (48 in this
database; effectively, P. R. Grant as first author)

==Grant, P. R.
Grant, P. R. as only author (17 in this
database; i.e., entire field contains only
Grant, P. R)

Shortcut:
You can also enter symbols (and get a
reminder of their functions by using the
Symbols pulldown menu and selecting the
desired symbol.

Do not use these controls
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How to Find References:
Multiple Criteria — AND Searches
AND searches: When you need to find references which each have more than one criterion, put
those criteria in a single request.

Examples:
“Grant, P. R.” “B. R. Grant”

“Grant, P. R.”

Grant, P. R. AND B. R. Grant in author
field (20 in this database; i.e., field
contains both Grant, P. R. as well as B.
R. Grant

1980 ... 1990
Grant, P. R. as first author AND published
between 1980 and 1990 (21 in this database)

“Grant, P. R.”
1980 ... 1990
==book
Grant, P. R. as first author AND published
between 1980 and 1990 AND a complete
book, i.e., not a chapter in an edited book (1
in this database)

FileName

BIBLIO.BRD

page 5

How to Find References:
Multiple Criteria — OR Searches
OR searches: When you need to find references which have alternative criteria, put the criteria in
multiple requests by clicking on the Add OR button under Criteria.
Example: a search for all references with BOTH B. R. Grant AND P. R. Grant as authors would look like this:
Makes previous
or next request
active
Click on the Add OR
button to create the
2nd and 3rd requests

Deletes the
active request
1st Request
“Grant, P. R.” “B. R. Grant”

“Grant, B. R.” “P. R. Grant”

The heavy bar,
text cursor, and
field outlines
mark this as the
active request.

“B. R. Grant” “P. R. Grant”

P. R. first author AND
B. R. elsewhere

OR
2nd Request
B. R. first author AND
P. R. elsewhere

OR
3rd Request
P. R. AND B. R. as
secondary authors

The requests shown, find 41 references with both authors as primary or
secondary authors.
Deleting the 3rd request finds 38 works with only those two authors and no
other authors.
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How to Find References:
Multiple Criteria — NOT Searches
NOT searches: When you need to find references which must NOT have some criteria, put those criteria in
multiple requests by clicking on the Add NOT button.

Example: a search for all journal articles with the taxon names Geospiza, Geospizidae and Geospizinae , but which
were NOT written by a Grant would look like this:

Click on the Add NOT button
to create the 2nd request

1st Request
X in the Omit box shows
that this is a NOT request

The heavy bar, text cursor
and field outlines mark this
as the active request.

geospiz* finds “geospiz” in a title
word followed by any number of
characters (...a, ...idae, ...inae) AND
Journal Article

NOT
2nd Request
Omit references with Grant in the
author field

The requests shown, find 21 references with all of the
criteria in the two requests
Deleting the 2nd request would find 42 articles by
including those written by a Grant.
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Beagle Investigations Return Darwinian Data: The Darwin’s Finch Data Resource (DFDR)
Galapagos Tourists (version 1.0 [BIRDD v2})
To return to this location:
Select Go to Tourists Table of Contents
under the "Script" menu
Tourist
DataBase Notes
View All
Data
View Summary
by Year
View Summary
by Month
Export
Data
Return to
Main Table of Contents

Notes on Tourist Data
About the Database
This database contains data on the number of tourists visiting the Galápagos islands in each
month from January 1979 through May, 1997.
Data were downloaded from Tourists Visiting Galápagos web page:
(http://www.polaris.net/~jpinson/tourist-tbl1.html)
That page cites the Galápagos National Park as the source of their data.

Notes About the Data
Exported Monthly Data
Exporting the data produces a tab-delimited text file with the following data:
Field/Column Heading
-------------------------Year
Month
n_Month
Year.Month
N.Tourists
--------------------------
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Comment
-----------------------------------------------------------4-digit year
3-character month name
1- or 2-digit month
decimal equivalent of year and middle of month, i.e.,
((n_Month/12) + 0.5); this facilitates graphing the data by time
number of tourists visiting in that month
------------------------------------------------------------
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